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Basics

Discontinuations

Discontinuation of Windows® 7 and Windows® 8

Microsoft® has discontinued support for the Windows® 7 operating system in January 2020. For compatibility
reasons, HiCAD 2020 SP2 and HELiOS 2020 SP2 were the last versions of our CAD or PDM system to support
Windows© 7. HiCAD 2021 and HELiOS 2021 no longer run under Windows© 7, Windows© 8 and the cor-
responding server operating systems (Windows Server 2008 R2, Windows Server 2012 and older) are also no
longer supported. If an attempt is made to install HiCAD 2021 or HELiOS 2021 on a computer with Windows©
7 or Windows© 8, a message appears.

Discontinuation of "old" HiCAD itemization

As of HiCAD 2019 the “old” itemisation, i.e. the itemisation that was used up to HiCAD 2017, will only be avail-
able for model drawings that were already itemized with these functions. From HiCAD 2021 onwards, only the
“new” itemization will be supported. Please also read the information given in the Conversion of Old Itemisa-
tions topic.

Discontinuation of "old" OpenGL versions

From HiCAD 2021 on, only OpenGL version 4.3 is used in all HiCAD modules. Until now this was only the case
with the module HiCAD Point Cloud. This means that HiCAD 2022 can no longer be run on computers without
a separate graphics card. To avoid possible problems with onboard graphics cards, we recommend using a
stand-alone graphics card.

Discontinuation of old figure format (FIG)

The following notes regarding FIG-FGA conversion are unnecessary if HELiOS is used in conjunction with the
HELiOS Vault Server.

Since HiCAD 2017 we support FGA as figure format (before that FIG). From HiCAD/HELiOS 2021 or HELiOS
2021 as an update for HiCAD 2019/2020 onwards, we require that all figures stored with HELiOS have been
converted to the new FGA format beforehand. To convert existing 2-D FIG files, the tool Converter_FIG_To_
FGA.exe is available in the exe directory of the HiCAD installation.

If there are still unconverted FIG files in the HELiOS document database at the time of the database update to
HELiOS 2600.0, you will be informed of the outstanding conversion of these files before the database update. In
this case, the conversion must be carried out before or at the latest directly after the update using Converter_
FIG_To_FGA.exe.
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Discontinuation of the "old" Create detail drawing function

With the release of HiCAD 2012, the previously valid workshop drawing functionality in Steel Engineering had
been extended to a function for general drawing derivation. The previous functions for detail drawings in Steel
Engineering were still available in the Detail drawing section of the Drawing menu. As of HiCAD 2022 (Version
2700.0) these functions are no longer supported.

Discontinuation of length measurements deviating from mm

HiCAD 2022 only supports drawings with the unit of measurement “Millimetres” (mm). The unit of meas-
urement is saved in the corresponding SZA, FGA or KRA file when saving a drawing or a part. Attempts to open
drawings with a different unit of measurement or to insert parts with a unit of measurement different from mm
will be blocked.

Discontinuation of HELiOS 32-Bit and HiCAD Viewer 32-Bit

As of HELiOS 2022 (Version 2700.0), a 32-Bit version for HELiOS and the HiCAD Viewer will no longer be avail-
able. However, the interface to 32-Bit applications such as Office will still be possible and is not affected by the
discontinuation of the 32-Bit installation of HELiOS.

Discontinuation of CADENAS PARTdataManager

As of HiCAD 2022 SP2, the CADENAS PARTdataManager will no longer be supported. Thus, the functions
Insert main part, PARTsolutions (CADENAS program) and Import PARTsolutions part will no longer be avail-
able from SP2 onwards.
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Service Pack 2 2022 (V 2702)

ICN
When calling a function via the context menu of a single part, this part will become the active part. Previously, the
part was then additionally marked in blue in the ICN. As of HiCAD 2022 SP2, this colour marking is omitted. This
does not apply to a multiple selection of parts!

Update drawing

Rearrange dimensions and annotations

If you have manually created or arranged dimensions or annotations, then as of SP2, you can specify that these
dimensions/annotations will be retained when the drawing is updated. The contents will - if necessary - always be
updated.

For this purpose, the dialogue window of the Update derived drawing function has been extended by the
Rearrange dimensions and annotations checkbox. If dimensions and annotations are to be retained, you must
deactivate the checkbox.

Keeping the dimensions/annotations can only work if the Adjust scale to frame size checkbox is inact-
ive in the drawing derivation.

Please also note the following:

Processing the drawing manually may result in creation or omission of new dimension base points or annotations in
the drawing. In such cases, it is not possible to retain the corresponding dimensions and annotations. This means
that these dimensions and annotations will be newly created when the drawing is updated and you must sub-
sequently adjust them again accordingly.
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Update only BOM and title block

Another new feature of the Update derived drawing function is the Update only BOM and title block check-
box. If this checkbox is active, only the BOM and the title block will be updated. All other changes such as scale,
dimensions, designations or new sectional views will not be executed. However, changes to the geometry will be
applied.

If this checkbox is active, then all other checkboxes will be inactive.
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Workshop drawing - Sheet metal part as assembly main part
Previously, the drawing derivation did not support the automatic generation of workshop drawings for assemblies if
the assembly main part was a sheet metal part. As of SP2, this is now possible - but only if the assembly main part is
a cassette-shaped or profile-shaped sheet metal part. The procedure for these assemblies is thus analogous to
assemblies in Steel Engineering, which have a profile as the assembly main part. The following dimensioning rules
have been adjusted for this expansion:

Dimensioning rule

Dimensions of assemblies,
(parallel or perpendicular to the profile
axis)

2 Assembly length ASSEMBLYLENGTH

19 Assembly height ASSEMBLY_HEIGHT

20 Assembly width ASSEMBLY_WIDTH

Position of beam sub-parts

8 Attached parts via outer contour ATTACHING_PARTS *

10 Attached sheets/plates with bores ATTACHING_SHEETS *

57 Attached plates, one chain of dimension for each
plate

ATTACHING_SHEETS_
SEPERATELY

*

83 Attached plates with bores, incl. bore in side view ATTACHING_SHEETS_
VERT

*

117 Beam sub-parts, not vertical to main part axis ATTACHING_PROFILES *

70 Attached beams/profiles with axis, to main part
axis, dimension via system axis

ATTACHING_PROFILES_
VERT

*

Position of bores in sub-parts

11 Bores in sub-parts SUBPARTBORES

84 Bores in sub-parts (bores of all sub-parts) incl.
bores + viewing direction

SUBPART_BORES_
VERT

89 All parts via bore ALL_PARTS_BORES

Dimensions of bores/hatchings in the main
part

45 Diameter of standard part bores in main part NORMBORE_
DIAMETER_MAINPART

44 Diameter of simple bores in main part BORE_DIAMETER_
MAINPART

46 Diameter of boltings in main part CONNECTION_
DIAMETER_MAINPART

* Here, the Dimensioning settings function under Bores / Boltings > Chains of dimensions for sub-parts can
also be used to control whether the first, the last or the first and last bore will be used for dimensioning.
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Itemisation - Sorting by article attributes

On the Attributes tab of the Itemisation with options function, you specify which attributes are to be taken into
account during identical part search and itemisation. As of SP2, a distinction is now made here between HiCAD part
attributes and HELiOS article attributes , whereby the individually indicated HELiOS article attributes are used
exclusively for sorting. The criterion for the differentiation is always the article master itself (usually the article num-
ber + index).

However, article attributes can only be selected if the Article master checkbox is activated on the General tab.
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In this example the article attribute Resourcing (COMPONENT_PROCUREMENT) is to be used as a sorting cri-
terion.

The drawing consists of 6 assemblies with different resourcing characteristics.

For the sake of clarity, in this example we select the six assemblies in the ICN and then call the Itemisation with

options function.

On the General tab we select the settings shown.
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On the Attributes tab we select the article attribute Resourcing (COMPONENT_PROCUREMENT) instead of the part
attribute Part type.
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The itemisation then gives the following result:
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Service Pack 1 2022 (V 2701)

Performance

Acceleration when zooming in with the mouse wheel

Analogously to the accelerated rotation of shaded representations, zooming in with the mouse wheel is now also sig-
nificantly faster in HiCAD 2022 SP1.

During a test with a customer drawing consisting of approximately 560.000 parts, zooming in in HiCAD 2022 took
only 6 seconds - compared to 14 seconds in HiCAD 2021.

Part selection
Previously, it was possible to move from one part within the part structure to the next higher and thus higher-ranking
part by holding down the left mouse button and then pressing the right mouse button during Part selection in the
drawing. As of SP1 this also applies vice versa.

If you press the middle mouse button instead of the right mouse button while holding the left mouse button, you will
return to the previously marked element in the part structure.
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Itemisation

Variable through holes

In previous HiCAD versions, incorrect results could occur in certain situations when comparing variable through
holes, for example if holes were drilled in opposite directions. These were recognised as different if their base points
did not match. As of HiCAD 2022 SP1, this behaviour has changed. This means that if the distances between the
start and the end of the drilling cylinder are equal, then the bores are considered equal. An exception are bores that
are only displayed as axes.

Let us look at the example displayed below. There, the part is present four times in the drawing. In all four parts, a
variable through hole was inserted which goes all the way through the part. Parts (1) and (3) were drilled from the
top to the bottom, parts (2) and (4) were drilled the other way around. The base point is always the centroid of the
entry surface. In (1) and (2) the bore is accurately displayed, in (3) and (4) only the axes are displayed.
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If the itemisation is now carried out, then parts (1) and (2) will be considered to be equal despite the different hole
directions. The same applies to parts (3) and (4). Parts (3) and (4) therefore have a different item number than (1)
and (2) because only the axes of the bore are displayed here.

Sub-parts of sheet metal parts

With HiCAD 2021, the possibility of itemising sub-parts of a sheet metal part in the part structure has been removed.
However, this has proved to be problematic in some customer drawings. Therefore, this behaviour is reversed with
HiCAD 2022 SP1.

In other words, parts that are sub-parts of a sheet metal part will be itemised again (if they are BOM-relevant).
However, this does not apply to flanges and bend zones. These are generally not itemised.

In the following image, the cuboid is subordinated to the sheet metal part as a sub-part and is therefore itemised,
unlike the flanges of the sheet.
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Treat regular parts like assemblies

To create a clear and efficient drawing, assemblies should be used for structuring. However, this is often not taken
into account, especially in "older" ways of working. Here it can sometimes be desirable to treat regular (BOM-
relevant) parts like assemblies during the itemisation, so that their sub-parts become separately numbered sections.
For these cases, the checkbox Treat regular parts like assemblies is available as of SP1 in the Configuration Editor
under Compatibility > Itemisation.

If the checkbox is active, regular (BOM-relevant) parts will be treated like assemblies during the itemisation in
HiCAD and their sub-parts will become separately numbered sections. The prerequisite is that you have selected
the mode by assemblies or - if a main assembly exists - by top level assemblies in the itemisation settings on the
General tab.

(1) Do not treat regular BOM-relevant parts like assemblies, (2) Treat regular BOM-relevant parts like assemblies
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Derived drawings

Sectional views of sheet metal parts

The generation of the section path during the automatic drawing derivation of sheet metal parts has been optimised
in HiCAD 2022 SP1.

n Processings that are located on the outer edges are now taken into account when determining the position of the
section path of sheet metal parts.

n Sectional views are generated at all bend zones of the flanges that are parallel to the defined front view (part ori-
entation).

see also Sheet Metal - What's new?
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Major Release 2022 (V 2700)

Licensing
As of HiCAD 2022, the Plot Manager is part of the HiCAD ALUCOBOND® Suite Premium.

Units
It is now possible to specify decimetres as the value for the surface and surface area unit. For this purpose, the selec-
tion box in the Configuration Editor has been expanded accordingly.

Uploading files into the ISD File Centre
From HiCAD 2022 onwards, you have the possibility to upload files directly from HiCAD if you are using the ISD File
Centre for data exchange with the ISD Support. For this purpose, the new Load file into ISD File Centre function can
be found in the Help menu.
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Multiple selection of Features and HCM-constraints
Analogous to the multiple selection of parts,the multiple selection of features or HCM constraints can now also be
cancelled by left-clicking in an empty area of the ICN or the drawing.

Line breaks when editing formulas
When using the Edit formula function, it is now possible to insert line breaks in formulas by using the key com-
bination SHIFT-ENTER. This allows you to distribute extensive formulas across several lines.

Limiting angle for shading
In previous HiCAD versions, the Limiting angle for shading function ensured that non- tangential transitions
appeared rounded in the shaded view. This function is no longer needed and thus has been removed. This applies
to both the drawing properties and the properties of 3-D parts.

Import of HASCO and STRACK standard parts
The functions for inserting HASCO and STRACK standard parts have been removed from the HiCAD user interface
with HiCAD 2021 SP1. As of HiCAD 2022, importing via the macros and via the API will also no longer be possible!

28 / 290 What's new?

Basics

../Grundlagen/Bedienung/Teileauswahl/Teileauswahl1.htm
../Grundlagen/eingaben/eingabe_formel.htm


Creating detail drawings
With HiCAD 2012, the previously valid functionality for creating workshop drawings in steel engineering has been
expanded to a function for general drawing derivation. For compatibility purposes, the previously available functions
for detail drawings in steel engineering were still available under Detail drawing in the Drawing menu. As of HiCAD
2022 (Version 2700.0), the previous functions for creating detail drawings will no longer be supported.

Create detail drawing for selected SE parts

Create + Print detail drawing

Use the Derive drawing function to create detail drawings.

However, in some cases the other functions can still prove useful for old drawings. Therefore, these functions were
combined in a separate submenu, under Drawing derivation > Up to HiCAD 2021.
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Enhancement when switching to standard itemisation since HiCAD 2018
Since HiCAD 2021, the Itemisation up to HiCAD 2017 mode is no longer available. In drawings that were created
with an earlier HiCAD version and - at least partially - itemised with the old itemisation mode, the previous itemisa-
tion must be converted accordingly before using the itemisation functionality in HiCAD 2021.

The following should be noted:

Since HiCAD 2021, it has been possible to define when bores are considered to be equal for identical part search
during the itemisation. For this purpose, the Processing standard checkbox is available in the dialogue window of
the General tab.

Processing
standard

Bores - including those created as subtractions - are considered to be equal, even if they are
represented differently. An exception to this are bores that are only represented as axes.

Processing
standard

Bores and corresponding processings are only considered equal if their catalogue/table IDs
match.

To avoid "surprises" when migrating inventory data, the new Activate the new option 'Processing standard' when
loading the itemisation settings from legacy data switch is available under System settings > Itemisation > Migra-
tion in the Configuration Editor.

If the switch is active, the Processing standard checkbox in the itemisation settings for the conversion is activated.
Otherwise it is deactivated.

This way you can convert your inventory data with and without considering the processing standard, compare the
results and thus find the right setting for your drawing.
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Derived drawings

Settings for view groups

The distance between views of a view group is automatically determined in such a way during the drawing derivation
that the result is a drawing that is as appealing as possible. However, under Automatic drawing derivation > Pro-
duction drawing > Usage-dependent > ... > View group in the Configuration Editor, you can set the minimal dis-
tance to be developed between the views. This is particularly important if it is already clear in advance that additional
annotations will have to be added to the drawing and that a certain distance will be required for this.

Deleting sectional views

Manually deleted sectional views of a workshop drawing remain deleted, even when the drawing is updated.
However, this only affects the respective view group the sectional view was deleted from. If other drawings exist for
the corresponding part, the sectional views in this view group are unaffected.

If the sectional view of a double stiffener is deleted, the two stiffeners will not receive a sectional view, even as
single stiffeners.

Shortened views

Since HiCAD 2020 SP1, the shortening of views is also possible for shaded views (Representation Shaded
with/without edges or Quick HiddenLine / Quick Hidden Grey), whereas the shortening marks are displayed in the
colour selected in the shortening parameters for break lines. This also applies to the shortening of shaded views in
workshop drawings.

Linking the axonometry to the main view

In workshop drawings where multiple assemblies are given out on one sheet, the axonometry is now linked to the
corresponding assembly's master view. If only one assembly is presented on the sheet, this does not apply.

Which view becomes the master view depends on the views selected for assemblies. The master view is determined
in the following order:

Front view ⃗Back view ⃗Top view ⃗Bottom view

If the front view is selected, it will become the master view. If it is not selected, the system will examine if the back
view has been selected. If so, this view will become the master view, etc.

Moving the master view will result in all of the linked views likewise moving.

Maintaining the perspective of axonometric views

If the perspective of an axonometric view is changed in a workshop drawing that was created with the Derive draw-
ing function, e.g. by rotating the view, the perspective will be maintained even when the drawing is updated. Auto-
matically created shortenings are recalculated accordingly. However, manually created shortenings will not be
retained.
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Consideration of the numbering mode during itemisation

If the By assembliesnumbering mode is selected during the itemisation, then the identical part search and the
assignment of item numbers will take place within the assembly. It may happen that two different parts from two dif-
ferent assemblies are given the same item number.

Previously, when creating a workshop drawing, only one of the two parts was output and detailed in cases like this.
As of HiCAD 2022, the numbering mode of the itemisation will be taken into account during drawing derivation. This
means that the parts will no longer be compared only according to the item numbers but also according to the level
of the part structure.

Example:

The drawing illustrated here consists of two assemblies, each including a composite panel, one of which contains
bores. If this drawing is itemised by assemblies, both composite panels - although different - will receive the same
item number.
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Now the drawing is created via the settings shown at the top right. The following illustration shows the drawing cre-
ated with HiCAD 2022 on the left and the drawing created with HiCAD 2021 on the right.
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Direction of angular dimensioning

When using the automatic drawing derivation, the angle for cuts, e.g. for profiles, was previously always dimen-
sioned on the outside of the part. As of HiCAD 2022, it is now possible to specify whether the dimensions are to be
created inside or outside for angular dimensions of cuts.

The setting can be changed in the STWDimsettings.xml file in the HiCAD SYS directory, in the line

<PARAM Name="ANGLEARRANGEMENT" Typ="INT" Value="0">

Value="0" outside

Value="1" inside

When HiCAD is newly installed, the STWDimsettings.xml file will automatically be created when starting HiCAD for
the first time - including the new line.

For update installations, you must add the new line to the existing file. There are two ways of doing this:

n You delete the existing STWDimsettings.xml file. The next time HiCAD is started, the file will be recreated with
the new line.

n You add the line manually.

Total quantity attribute
Since HiCAD 2021 SP1, it has been possible to determine how often each part exists in the drawing during the
itemisation. This value is assigned to the Total quantity (%06) attribute. Previously, this was only possible if the By
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model drawing mode was selected as numbering mode for the itemisation.

As of HiCAD 2022, the total quantity is now also calculated if By assembly is selected as the numbering mode. This
means that if the drawing contains multiple identical assemblies (on the same hierarchical level), their total quantity
in the drawing is determined. For the parts belonging to an assembly, the total quantity within the assembly is
determined.

Example:

The illustrated drawing consists of three assemblies (1) to (3). Assemblies (2) and (3) are identical and receive the
same item number. The total number of assemblies with item number 2 is 2. The other parts are counted by
assembly, i.e. the total number of perforated sheets per assembly is 2.

In contrast, let us consider the following drawing, consisting of two assemblies (1) and (2). A copy (3) of assembly
(2) is subordinated to assembly (1). When itemising by assembly, the assemblies (2) and (3) will receive the same
item number, but since the two assemblies are not on the same hierarchical level, their total quantity is 1.

If the total quantity is to be calculated during the itemisation, then the Calculate total quantity check-
box must be active underModelling > Part properties in the Configuration Editor.
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If the checkbox is active, the number of times each part appears in the model drawing is determined during itemisa-
tion (only in itemisation mode By model drawings). This value is assigned to the attribute Total quantity (%06) and
automatically updated when editing the parts, e.g. when deleting or repeating parts. In very large constructions, this
update can have a negative impact on performance, for example when deleting assemblies. In such cases, the
checkbox can be deactivated. If this is the case, then - after a restart of HiCAD - the next time the drawing is loaded,
the attribute Total number of the affected parts will be deleted instead of calculated.

Saving/Referencing parts

The dialogue of the Reference part, Save, Detail drawing function has been altered slightly.

n The texts in the Referance part section have been adjusted.

Dialogue with and without HELiOS

n The prompt regarding the Fitting CS now appears before the selection of the storage folder. The prompt only
appears if a Fitting CS is already in place at the time of referencing.
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Path for referenced parts
The Path for referenced parts function in the Drawing > Extras > Temporary settings menu is no longer available.
To change the path for referenced parts, open the Settings in HiCAD and adjust the folder for the L: identifier under
Directories. Then restart HiCAD to let this setting become active. The change is related to one specific workplace
and may have to be carried out on all other workplaces as well.

Saving the ICN display with the drawing
HiCAD offers the possibility to save the ICN display together with the drawing. In this way, the HELiOS attributes are
also displayed in the part structure of the HiCAD Viewer. It is either possible to temporarily perform the setting during
the current HiCAD session or set it as a default setting in the Configuration Editor.

Sometimes generating the ICN can lead to considerable waiting times. As of HiCAD 2022, if the Save ICN display
with drawing status is active, the new message

Save drawing (generate ICN designations for Viewer)

will be displayed in the user guidance (info toolbar) during the saving process. This enables you to see that the
status is active and could possibly be the cause of the waiting time.
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Standard part points
In previous HiCAD versions, it could happen that dimension base points on standard parts were lost if, for example,
the representation was changed from exact to simple or another standard part type (e.g. screw of another standard)
was changed.

For this reason, the Standard part point option is available as of HiCAD 2022. This point option provides the origin of
the part coordinate system of standard parts, which remains stable even when standard parts are exchanged.

The point option cannot be activated via the point option menu. Instead, the following activation options are avail-
able:

n If a dimensioning or annotation function is active, the point option can be selected via the Autopilot, provided it
is active in the Autopilot Settings toolbar.

n In other functions, the point option can be used as follows:

l Move the cursor over the corresponding standard part.

l Activate the Point options menu.

l

Select the point option Input via keyboard and enter NT. Then the point on the part under your cursor
will be determined.
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2-D

Service Pack 1 2022 (V 2701)

Settings of SKIZZTEC.DAT moved to Configuration Editor
The settings for 2-D grids that were formerly available in the file SKIZZTEC.DAT have been moved to the Con-
figuration Editor (ISDConfigEditor.exe).

There you can find the settings of the former .DAT file at:

n System settings Sketches > Grid, 2-D sketching functions.

Change GE parameters
The menu with the functions for changing the GE parameters has been revised. Double functions have been
removed.
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Major Release 2022 (V 2700)

Start grid length when using the 2-D sketching tool
The entry from the system file SKIZZTEC.DAT Factor for distance cursor has been moved to the Configuration
Editor. There, at System settings > Sketches > 2-D sketch grid you can define the distance of the Grid as a per-
centage value of the graphics window height and the screen resolution. For example, if you select a point with the 2-

D function Polyline (2-D Geometry > Draw) and then move the mouse, the distance is displayed at the cursor.

(1) With the distance of 3.333, this is e.g. 5 by default.

(2) If you set the distance to 10 in the Configuration Editor and restart HiCAD, the default value is 20.
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Snapping HCM dimensions and parametric dimensions
If the cursor points to the dimension figure of a HCM dimension or parametric dimension, the geometry behind
these dimensions was preferably snapped in previous versions. This behavior has changed in HiCAD 2022. From
now on, HCM dimensions and parametric dimensions are preferred.

(1) before HiCAD 2022, (2) from HiCAD 2022

Import of HASCO and STRACK standard parts
The functions for inserting HASCO and STRACK standard parts have been removed from the HiCAD user interface
with the release of HiCAD 2021 SP1.

As of HiCAD 2022, import via the macros and via the API is also no longer possible!

What's new? 41 / 290

News Overview



3-D

Service Pack 2 2022 (V 2702)

Views - Show/Hide parts
New in the context menu for 3-D parts and part lists is the Show part list in view selection, hide all other parts

function. This function shows only the active part or - in case of a multiple selection - all selected parts. All
other parts will be hidden. This applies to all currently selected views.

Tip:
To subsequently show all parts of the drawing again, select all parts in the ICN with CTRL+A and then select this

function again or select the Show part list in view selection function.
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Divide surface

The Divide surface function has been revised and extended once again.

n To remove selected surfaces or lines, a button is now available in the dialogue window.

n As of SP2, dividing in polyline mode is also possible if multiple lines converge at one point. However, the lines
must not intersect. For more complex divisions in a plane, sketch mode is recommended.

n Freeform curves can also be used for divisions.

n The error texts have been revised.

n To divide whole cylinders or cone surfaces in polyline mode, at least two lines are required. These must divide
the surface into at least two new surfaces.
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n In sketch mode, surfaces from sectional and detail views as well as cut-outs or sheet developments are not per-
mitted. In polyline mode, this applies analogously to lines.

n In polyline mode, the Perpendicular Point F point option of the Autopilot is no longer supported when selecting
the first point of a polyline.
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Sketch Technology

Close polyline

The context menu that is displayed while drawing polylines after pressing the right mouse button has been extended

by the Close polyline function.

This function closes the current polyline, i.e. the last point will be connected to the start point of the polyline by a
new line. The sketching tool will remain active afterwards, so that you can directly draw the start point of another
polyline.

Marking of the current drawing plane in 3-D sketches

As of SP2, when working with 3-D sketches, the current drawing plane is displayed in a lighter colour during sketch-
ing.
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Drawing of tangents

The functions

n Tangent between 2 lines and

n Tangent to surface

have been combined into the new Tangent function .

n Points, lines and surfaces can be selected for the start and end of the tangent.

n A dynamic preview of the tangent is displayed and the selected start point is visualised.

n The tangent that comes closest to the click points for start / end is always selected. There is no additional query
and for tangents to a surface the determination of additional points is omitted.

n For point determination, the point options of the Autopilot settings toolbar can be used - including the Online
point O point option.

n If not set otherwise, HCM constraints are automatically assigned. These can be suppressed during drawing by
holding down the SHIFT key.

n By right-clicking, a context menu can be activated analogously to other sketch functions.
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Optimisation of value input (space bar) when drawing sketches

If you want to enter a value, e.g. a length or a radius, explicitly via the keyboard when drawing graphical elements,

you can select the Value input function in the context menu or alternatively simply press the space bar.
HiCAD will then display the calculator and you can enter the desired value. As of SP2, the distance and angle to the
last point or the X and Y distance to the last point can be entered in one step. The two values must be separated by a
space.

Which entries are possible depends on the respective function and the mode selected there.

Function Distance + Angle XY-grid Free On axes

Line Distance Angle X distance Y
distance

X distance Y
distance

Length

Rectangle - X distance Y
distance

X distance Y
distance

-

Circle - Radius Radius -

Arc - Radius Radius -

These possibilities do not apply to the start point.
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Transition from arcs

The Transition from arcs function has been revised. Overview of the new features:

n After selecting the start point, the direction in which the arc will be drawn is visualised by an arrow.

n As soon as you move the cursor near a line afterwards, the possible arc will be displayed as a dynamic preview.

n If not set otherwise, HCM constraints are automatically assigned, which can be suppressed by holding down the
SHIFT key - as with other sketch functions.

n As with the other sketch functions, a context menu can be activated by right-clicking before a point is applied.

Example

The illustration shows the selected start point on the left and a selection of possible transitions on the right.

48 / 290 What's new?

3-D

../3DSkizzen/Zeichnen/skzbogen.htm


Weld seams and symbols

Clone weld symbol

New in the pull-down menu of the 3-D Dimensioning + Text > Symbols > Weld function is the Clone weld symbol

function.

This function allows you to copy existing weld symbols in the drawing and to assign copies to other weld seams. The
function is also available in the context menu for weld seams.

Please note that the function will only clone the representation of the weld symbol. The content of the
symbol will be read from the selected weld seam line.

Example:

The illustration shows a free weld seam symbol (1) and a labelled weld seam(2). The weld symbol (1) is cloned and
repeated and selected as the weld seam line (3). (4) shows the result.
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Tooltips for additional symbols

As of SP2, tooltips are also displayed for additional symbols in the dialogues for weld seams and weld symbols.
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Text - Itemise part

The Itemise part function has been extended. The Part selection area is now additionally available here.

There you have the option of selecting whether the selected part is to be annotated (as previously) or only the 1st
sub-part-level. If the 1st sub-part level option is active, then the highest superordinate part of the 1st sub-part level
that is BOM-relevant will automatically be searched for and annotated, starting from the selected part. This can be
particularly useful in complex drawings if only the assemblies are to be annotated.

Example:

We consider the illustrated drawing.
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Now the Itemise part function is called, the option 1st sub-part level is activated and the L-profile (1) is selec-
ted. In this case, the highest superordinate and BOM-relevant part is the Assembly Tensioning Elements, which is
highlighted in colour by HiCAD. This assembly will then be annotated.

If the function had been executed with the Selected part option, the L-profile would have been annotated instead.
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Hatching in section and cut-out

The Hatch section + cut-out function has been completely revised. It affects the active view and allows a pre-
view of the changed hatching. Also new is that a distinction is now made between "normal" hatchings and insulation
hatchings.

Please note that for certain hatchings no or only a schematic preview can be displayed.
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Service Pack 1 2022 (V 2701)

Views

New dialogue when creating new views

The previous functions

Views > New > Standard

Views > New > New list view, Select parts

Views > New > New list view, Copy from another view and

Views > New > New list view, Copy from active part list

have been combined into the function New view, without link with a new dialogue.
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The new function is clearer, offers better user guidance and enables list views to be defined much more quickly.

In addition, the representation type of the view, the view name and the scale can now also be selected directly. It is
also possible to assign view captions.
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Changed meaning of the term "view list"

As of HiCAD 2022 SP1, the term "view list"stands for a multiple selection of views - in analogy to part lists.

The previous use of the term meaning "list of parts displayed in a view" has been replaced by part list of the view or
part list for short.

Highlighting of view lists

If a view list is available, i.e. if multiple views are selected, then all selected sheet views will be highlighted by a col-
oured, wider and dashed view frame. The frame representation corresponds to the settings selected for the active
sheet view in the Configuration Editor - but dashed.

Automatic assignment of numbers as view designation

Up to now only capital letters were automatically assigned in view markings, i.e. the smallest letter not yet assigned
was suggested as a designation (detail views start with Z and run backwards in the alphabet). If, for example, the
drawing contained sectional views with the designations A and B, then designation C was automatically suggested
for the next sectional view and so on. If the drawing contained sectional views with the designations A and C, then
the next letter not yet assigned was searched for, i.e. B.

As of HiCAD 2022 SP1, this behaviour also applies to the use of numbers in view markings. This means that, when
creating a new sectional or detail view or for view markings according to the arrow method, the smallest number not
yet used will be searched for in the view dialogues of the corresponding functions and suggested as a designation.
Views that only have a caption (without a designation in an original view) are also taken into account.

Whether a letter or a number is suggested depends on the last designation used. For example, after a sectional view
with the designation A, a letter will be used again for the next sectional view, and after a sectional view with the des-
ignation 1, a number will be suggested again.
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Views window of the ICN - Changed column headers

Due to the risk of confusion between the column header Designationin the Views window of the ICN and the term
Designation (view designation, section designation, detail designation) in different view dialogues, the column
header Designation in the ICN has been changed to Number/Name.

Show/Hide isolated points in view

Analogously to assembly points, isolated points can now also be shown/hidden in views. The Show/Hide elements

in view function has been extended accordingly.

Isolated points also include named points, symbol points and fitting points.

Please note that isolated points can be hidden globally by means of the Drawing > Others > Visual... function. If you
have hidden isolated points in this way, they cannot be shown again with the Show/Hide elements in view function.
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Please note:

n The function only affects the currently active view. Multiple selection of views is not possible.

n For assembly points and isolated points, hiding always affects only the existing points. This means that if further
isolated points or assembly points are created, these will be visible. You must first recalculate the view in which
the isolated points and assembly points are already set to Hide. To do this, use the functions found under Recal-
culate views in the context menu of the Redraw function.

Improvements for view captions
n The function View caption has been renamed to Create/edit/delete view caption(s).

n The settings of the View caption dialogue window can now be saved as favourites. In order to do this, click on

the symbol at the bottom left of the dialogue window. You can find more information on managing favour-
ites under Favourites in the HiCAD Basics.

n The checkbox View caption has been renamed to Show caption.

n View captions can now be aligned above or below the view, not only centred but also left-aligned and right-
aligned. The alignment refers to the geometry displayed in the view (without annotations).
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Below view, left-aligned

n As of SP1, the alignment can no longer be changed in the context menu for view captions.

n To edit a view caption, it is now also sufficient to double-click on the caption to display the View caption dialogue
window.

n If the active view is a sectional or detail view or a view marked according to the arrow method, the View caption
field in the View designation dialogue window is locked and greyed out.
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Sketches

Extended range of points on the Autopilot

When sketching planar sketches and 3-D sketches, in addition to the points in the sketch, the point options X and Y
are now also offered for the last point found by the Autopilot (with the exception of the point option O). This does not
happen directly when you "run over" a point, but only when you briefly stay on this point with the mouse. This point
will then be visualised graphically.

Example:

You move the mouse over the middle of a line. Then the Autopilot will offer the point option Midpoint. However, you
do not click but move the mouse further after a short moment. The midpoint will be visualised graphically and from
now on the Autopilot will offer the point options X and Y for the coordinates of the midpoint.

As of HiCAD 2022 SP1, this option is also available when inserting isolated points in a sketch.
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3-D sketches - New option: Do not leave drawing plane

For 3-D sketches, the checkbox Do not leave drawing plane is also available in the Angle+Distance grid, XY - grid
and Free modes. Activating the checkbox causes selected points outside of the current drawing plane to be pro-
jected onto this plane and thus to be drawn in a plane. For the On axes mode, the checkbox Do not leave axis is
available, working in the same way.

Example:
The start point of the line is point (1). Point (2) is selected as the following point. If the checkbox is inactive, (2) will
be the determined point. If the checkbox is active, point (3) will automatically be determined.

Apply direction

As of HiCAD 2022 SP1, the Apply direction function is also available in the context menu of the Sketching
Tool. With this function the direction of the line shown in the preview is taken over as the direction for the next line to
be drawn.
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Annotations

3-D annotation with interruption of lines and hatchings

You can set whether the lines of parts and hatchings behind a 3-D annotation should be interrupted under System
settings > Annotations > Part annotation in the Configuration Editor. If the option Interrupt background lines is act-
ive, hatchings and lines will be hidden. This applies to the representations Glass Model, HiddenLine, HiddenLine
dashed and Shaded with Hidden Line.

Please note that this option is read in when HiCAD is started and is active by default. Changes will only take effect
after a restart.

Point option O when setting annotations

When determining the reference point of a 3-D annotation, the point option O (online to edge through point) is now
automatically activated in the Autopilot settings toolbar. This also applies to the setting of surface symbols.

This applies to the following functions:

n 3-D Dimensioning + Text > Text > Annot.,

n 3-D Dimensioning + Text > Text > LLine,

n 3-D Dimensioning + Text > Text > Standard,

n 3-D Dimensioning + Text > Text > Item.,

n 3-D Dimensioning + Text > Symbols > Surf... and

n 3-D Dimensioning + Text > Symbols > Surf... > New
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Dimensioning

Unit of measurement

In the settings for the parameters for dimensions, the designations for inches (am.) and " (brit.) have been replaced
by ft in and ' " respectively.

Newly available for selection are in and ". This means that it is now also possible to output values larger than 12
inches completely in inches. Previously, the output was a combination of feet and inches.

Delete weld seam symbols

There are new functions for deleting weld symbols under 3-D Dimensioning+Text > Symbols > Weld.
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Process parts

Divide surface

The dividing of surfaces has been modernised in HiCAD 2022 SP1. The previous function Insert edges in surface /

Divide surface (under 3-D Standard > Tools > Edge) has been replaced by the new function Divide surface
. You can find the new function under 3-D Standard > Tools > Surface.

With this function you divide surfaces of the active part. For example, the side of a sheet can be divided into two sur-
faces that can be addressed separately and thus can also be coated, coloured or hatched differently.
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Two modes are available for dividing surfaces.

Use sketch for dividing

In this mode a sketch is used for dividing. The lines are drawn out internally in the Z-direction of the sketch to form
surfaces and are intersected with the surfaces to be divided. Each intersection curve that is closed or goes from
edge to edge splits the surface into two pieces. Lines ending in a surface are extended there to enable dividing.

Use polyline for dividing.

In this mode, instead of a sketch, polylines consisting of straight lines one at a time are used for dividing. These lines
must lie exactly on the surface that is to be divided. As a result the surface will automatically be specified and does
not have to be explicitly selected. Due to the constraints, only flat, cylindrical and conical surfaces are allowed; the
division of freeform surfaces is not possible in this mode.

In the following example, the part (1) was divided via the sketch. After calling the function, the option Tangentially
connected surfaces was selected, then the surface (2) and the sketch (3) were selected. (4) shows the result.
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A feature with the name Divide surface is created for each division. Double-click on the entry in the feature log to
start the Divide surface function dialogue, for example to process the sketch on which the division is based, to
change the surface selection or to select a different polyline.
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Clean up intersections

The Clean up intersections function has been completely revised/modernised and is now identical to the func-
tion of the same name under Sheet Metal > Further functions > Extras.

The main improvements:

n extended possibilities, analogous to the clean-up of sheet metal parts,

n improved treatment of multi-part sheets,

n improvement of the automatic selection of the surfaces to be processed,

n consideration of external references and

n simultaneous processing of multiple collision parts.

Example:

The pictured sheet metal part colliding with two cylinders should be cleaned up.
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The processing should be perpendicular to the surface and all surfaces on the sheet should be processed. There-
fore, the automatic surface selection is selected.

The result:
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Major Release 2022 (V 2700)

Sketches

N-gon

The previous N-gon function has been revised. The new N-Gon function now also uses the sketching tool.
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Rectangle with centre point

Sketch > Draw > Rectangle > With centre point

With the new Rectangle with centre point function you draw a rectangle by selecting the centre point and
dragging the rectangle. The Sketching Tool is started for this purpose.
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Point option O for circles and arcs

With the new sketching functions in HiCAD 2021 SP1, the point option O was previously not available on Autopilot if,
instead of a point, a line could also be selected, for example a tangent line to a circle. This behaviour has changed
when sketching circles and arcs in HiCAD 2022 in the following way:

n The point option O is also available in the case of a tangential line also being selectable instead of a point.

n If the point option O is set to determine the centre of a circle or arc or the start point of an arc, then the coin-
cidence constraint is set on the underlying line. If the point is on either the circle or the arc, no coincidence con-
straint will be set.

Example:

In the illustrated example, an arc is drawn using the Arc function. For the centre, start and end points of the
arc, the point option O is used.

(1) Original sketch, (2) Arc centre point, (3) Arc start point, (4) Arc end point, (5) Outcome with coincidence con-
straints
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Create and process parts

New part from 3-D sketch

As of HiCAD 2022, the algorithm of the New part from 3-D sketch function has been improved. These
improvements have weakened the requirements for the 3-D sketch:

n The sketch may only contain straight lines, curves are not allowed. Auxiliary geometry is allowed but will be
ignored.

n The lines of the sketch must not intersect or coincide (lie on top of each other).

n The sketch must consist of lines that are supposed to become edges of the solid to be created. Ideally, all edges
should be included as lines in the sketch.

n At least two lines must converge at each line end. If this is not the case, the lines are evaluated as errors and visu-
alised accordingly in the graphic. This way, even small gaps in the sketch can be found quickly.

If the lines of a 3-D sketch are not sufficient to create a solid, HiCAD will - if possible - automatically insert the miss-
ing body edges. In the preview, these edges are visualised in the same colour as the resulting part. The number of
lines added and of surfaces created are now displayed in the dialogue.

The edges automatically added by HiCAD cannot be influenced. If they do not correspond to the desired
result, you must add the missing lines to the sketch.

Error messages will only be displayed in the dialogue directly after calling the function if the 3-D sketch does not
meet the requirements and it was not possible to create a useful solid, even by adding lines.
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Chamfer

The dialogue of the Chamfer function has been redesigned - with a wider selection of chamfer elements,
improved preview and modification of parameters, extended value input and much more.
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New and enhanced options: 

n In addition to the selection of individual edges and surfaces, additional elements can now be selected for cham-
fering via a context menu.

n The previous Chamfer point with adjacent edges function has been omitted. Instead, you use the Adjacent
edges of a point function shown in the context menu above.

n Chamfering corners is no longer done via the Chamfer function but via the independent Chamfer corner

function.

n For edges, the direction of the edge is visualised. This depends on the cursor position when selecting the edge.

n For variable chamfering, intermediate points can be specified as either a percentage of the length of the edge to
be chamfered or as a point option. Points that are determined via a point option do not have to be located on the
c-edge. They will be projected automatically.

n Segments of edges can also be chamfered - both constantly and variably. The start and end points of a segment
can - just like the intermediate points in variable chamfering - be specified as a percentage or as a point option.

n The preview has been improved and can now be updated either automatically or alternatively by clicking.

n When changing parameters of already selected chamfer elements, multiple selection is possible.

n In theElement snapmode, the chamfering function is now also available in the context menu for edges and sur-
faces.

n As long as you do not exit the dialogue window by clicking the OK or Cancel button, you will be able to chamfer
more elements.

n The value input in the dialogue window can contain variables and formulas. In addition, a context menu with fur-
ther input options can be called by right-clicking. For example, values can also be picked in the drawing.

n The function can also be used via the HiCAD API.

n Chamfered edges and surfaces of a part can be edited subsequently via the Chamfer feature.
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Fillet
n When filleting, it is now also possible to select all edges adjacent to a point in one step. For this purpose, the con-

text menu for the selection of elements to be filleted has been extended by the function Adjacent edges of a
point.

n Filleting of segments is now also possible via variable filleting. Please note that the start point (in relation to the
direction) must be located in front of the end point.
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Divide along direction

The Divide along direction function has been extended.

n Part selection has been newly added to the dialogue window. The system will always choose the active part for
processing, with the name being displayed under Part. If the function is called while an invalid part is active (e.g.
a dummy part), the text Select part will be displayed instead of the part name. In this case, you can select the
part to be processed directly in the ICN or in the drawing.

If you want to process a part other than the one displayed, click on the symbol and select the desired part
in the ICN or in the drawing.

n Another new addition is the Apply button. You can execute the division by pressing this button. However, in con-
trast to OK, the dialogue window remains active and thus further parts can be processed.

n The preview has been improved. In addition to the direction, the division points and the gap, the resulting seg-
ments are now also immediately visualised in the drawing. This also applies to the Divide along direction func-
tion in steel engineering.
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n If the main feature is selected in the ICN, in addition to the original part, all associated segments in the drawing
are now also highlighted in colour. This also applies vice versa. Analogously, this applies to the steel engineering
function Divide along direction.

n If the main feature Divide along direction is activated / deactivated, the associated features from division are
also automatically activated / deactivated. At the same time the dependent parts will be recalculated accord-
ingly, i.e.:
l If the main feature is deactivated, the original part will be restored and the segments will become dummy

parts.
l If the main feature is activated, all segments will be restored.

This also applies to the Divide along direction function in steel engineering.
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Divide with sketch

The Divide function has been renamed to Divide with sketch and extended.

n Part selection has been newly added to the dialogue window. The system will always choose the active part for
processing, with the name being displayed under Part. If the function is called while an invalid part is active (e.g.
a dummy part), the text Select part will be displayed instead of the part name. In this case, you can select the
part to be processed directly in the ICN or in the drawing. If you want to process a part other than the one dis-

played, click on the symbol and select the desired part in the ICN or in the drawing.

n The sketch can be deleted automatically after the division.

n If the main feature is selected in the ICN, in addition to the original part, all associated segments in the drawing
are now also highlighted in colour. This also applies vice versa.

n If the main feature Divide along direction is activated / deactivated, the associated features from division are
also automatically activated / deactivated. At the same time the dependent parts will be recalculated accord-
ingly, i.e.:

l If the main feature is deactivated, the original part will be restored and the segments will become dummy
parts.

l If the main feature is activated, all segments will be restored.

n If a sketch has HCM dimensions, they are transferred to the feature as parametric dimensions. If a parametric
dimension is changed in the graphics window, this change will adjust the associated HCM dimension.

Limiting angle for shading

In previous HiCAD versions, the Limiting angle for shading function ensured that non- tangential transitions
appeared rounded in the shaded view. This function is no longer needed and thus has been removed. This applies
to both the drawing properties and the properties of 3-D parts.
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Number of holes in a hole pattern

When using the Hole pattern function, the dialogue window now directly shows how many holes would be created
based on the configured hole pattern. Partially created holes (e.g. holes that are located at the edge of the processed
area) will be counted as entire holes here. This value is also displayed in the Feature of the hole pattern.
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Dimensioning

Snapping of HCM and parametric dimensions

Thus far, when the cursor was pointing to the dimension figure of an HCM or a parametric dimension, the system
preferably snapped the geometry behind it. In HiCAD 2022, this behaviour has changed. As of now, HCM and para-
metric dimensions are preferred.

Top: before HiCAD 2022; Bottom: since HiCAD 2022
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Renaming of the function group Surface/Edge

The function group Surface/Edge has been renamed to Symbols and moved within the 3-D Dimensioning +
Text ribbon.

A new feature is that the functions

Free weld seam symbol and

Annotate weld seam

are also available here.

Grid annotation

As of HiCAD 2022, the functions for Grid annotations can be found under 3-D Dimensioning + Text > Symbols >
Grid....
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Annotations

New file format

With HiCAD 2022, the internal data format of annotations has changed. During the creation of new annotations (also
in drawing derivations and sheet developments), the new format is always used. Visually, there are no differences to
the "old" format. When loading a drawing that contains annotations created before HiCAD 2022, the following mes-

sage appears:

If you click on Yes, the previous annotation tags will automatically be converted to the new format. A message is
then displayed, indicating whether or not all annotation tags could be converted, e.g.

In the ISD Configuration Editor, under Compatibility > Annotations > Part annotation, 3-D, you can preset how to
proceed when drawings with "old" annotation tags are loaded and whether a message should be output after a con-

version.

The conversion of old annotation tags can also be done automatically by setting the Convert part annotations of the
drawing when loading? parameter to Yes, without query.
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Changed context menu

The context menu for part annotations has been changed.

n The Move part annotation function is no longer available. Annotations can now be moved simply by using drag
& drop.

n Base points, i.e. additional leader lines, can now also be deleted via the context menu.

n A new feature is the Insert inflexion point function, which allows you to insert inflexion points at the leader lines
of an annotation.

n The Delete inflexion point function removes all inflexion points of an annotation.
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Views

View marking according to arrow method

In practice, it is sometimes advantageous to mark views according to the arrow method. This method allows you to
represent the viewing direction of a derived view in the original view by the use of a corresponding symbol and a view
marking. In mechanical engineering, for example, the viewing direction is marked by an arrow and in civil engin-
eering by a circle with a triangle, with the view marking in the circle.

With the new View marking according to arrow method function, HiCAD supports this method.
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Example:

In the illustration, views of a 3-D model have been generated using the 4 standard views (3-D) function.

86 / 290 What's new?

3-D



In the following illustration, the front view, the left side view and the top view have been marked according to the
arrow method - with the axonometry as the original view.

The default settings for view markings can be defined under Drawing > Views > Ident > Arrow method in the Con-
figuration Editor.
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View caption

Previously, captions could only be assigned to sectional and detail views. With the new View caption func-
tion, this is now possible for all view types.

The default setting for the position of the caption can be defined under Drawing > Views > Ident in the Configuration
Editor.
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Sectional and detail views - extended dialogues and options

Based on the new functions View marking according to arrow method and View caption, the dialogues for defining
and editing Sectional and Detail views have been revised and extended.

n The identification of the cutting sequence and the annotation of the original view can be configured individually
and are visualised directly in the drawing. Annotating can now also be done on one side and with symbols for
civil engineering (circle with triangle and rectangle symbol at the end), as well as beside the arrow. In addition,
identification can also be done without an arrow.

n The identification of the detail in the original view can be configured individually. As of HiCAD 2022, the Exact
detail and Rectangle (filleted) views are also available for outlines of the identification.

n The captions of sectional and detail views an be configured individually.

n The identification of sectional and detail views can be assigned to a specific layer.

n The Detail view Cuboid function also supports identification and annotation of the original view, as well as con-
figurable captions for detail views.
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Identification of sectional views
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Identification of detail views
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Detail view with exact outline view

The default settings for identification in sectional and detail views can be defined under Drawing > Views > Ident >
Sections or Drawing > Views > Ident > Details in the Configuration Editor.

View selection in the ICN

For various view functions, HiCAD requests the selection of a reference view, for example in order to copy data from
this view. As an example, this is the case for the functions List from ref. view and Copy shortening. In these cases,
the view could previously only be selected in the graphics window and therefore only in the current area. As of
HiCAD 2022, the view selection in the ICN is now also possible in such cases.

In this context, the view functions

Show/unfreeze views, Individual

Hide views, Individual

Freeze views, Individual

have also been adjusted. The view can now be selected either in the graphics window or in the ICN. The entry of a

view number is no longer necessary. Furthermore, the function Select view, via list has been removed.

92 / 290 What's new?

3-D

../3DAnsichten/bearbeiten/3dans_verkuerz3.htm
../3DAnsichten/Ansichtsfunktionen/3danseinblenden.htm
../3DAnsichten/Ansichtsfunktionen/3danseinblenden.htm
../3DAnsichten/Ansichtsfunktionen/3danseinblenden.htm
../3DAnsichten/Ansichtsfunktionen/3danseinblenden.htm


Show/Hide elements in view

The dialogue of the Show/Hide elements in view function has changed. The window has been tightened and,
instead of checkboxes, the settings can now be selected via different selection boxes.

Hiding edges via the limiting angle is no longer available and, as of HiCAD 2022, you use the new Show/Hide edges

function to show/hide any edges of the drawing.
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Show/Hide edges

The Show/Hide edges function allows you to show or hide any edges of your drawing in the active view or in
all selected views. The settings have an effect on the following representations:

n Glass Model,

n HiddenLine,

n HiddenLine dashed and

n Shaded with Hidden Line.

If the desired edges are to be shown/hidden in multiple views, select the corresponding views in the ICN before call-
ing the function.

After calling the function, the dialogue window Show/Hide edges will be displayed.

Then, select the desired edges in the drawing. Each selected edge will be included in the list in the dialogue window
and visualised in colour in the drawing. If an edge that is contained in the list is selected again, it will be removed
from the list. In multi-part sheets, when an edge is selected, the congruent edges of the flange and bend zone are
also automatically selected.

When clicking on an entry in the list, the corresponding edge in the drawing will be highlighted in colour.

If multiple views were selected when the function was called, it is possible to specify for each edge contained in the
list whether the edge is to be hidden only in the active view or in all selected views.

You can hide the edges presented in the list by clicking OK.

When you call the function again, all hidden edges will be listed in the dialogue window. To show the edges again,
simply delete the corresponding list entry.
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Shaded, without highlighted edges

The new Shaded, without highlighted edges function provides another representation mode for views. This
function shades the parts of the active view and displays all visible edges, with the exception of highlighted edges.
Highlighted edges are theoretical edges that occur in places where there is no clear edge due to a rounding.

This display mode can be useful for improving the performance while working on large drawings in the model view.

(1) Shaded with edges, (2) Shaded, without highlighted edges, (3) Shaded without edges

You can find these functions
n in the context menu for views,
n in the transparent toolbar and
n under Representation in the View ribbon.
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Sectional views with Steel Engineering plates

As of HiCAD 2022, it is also possible to define for Steel Engineering plates whether or not the coating should be
marked in the Sectional view, analogously to Sheet Metal parts. The coating is displayed in the form of an offset
edge, the so-called coating line. The settings for the representation of the coating line can be found under Drawing
> Annotations > Coating line in sectional view in the Configuration Editor.

The representation of the coating line can also be changed subsequently. To do this, right-click on the coating line in
the required view and choose the desired function in the Coating symbol context menu.

In addition, if a sectional view is active, the representation of the coating lines can also be changed via the context
menu for Steel Engineering. To do this, right-click on the plate in the sectional view and then select the Coating line
function under Properties.

Weld seams and weld symbols
n The Insert weld symbol function has been renamed to Free weld seam symbol and provided with a new func-

tion icon .

n

A new feature is the Annotate weld seam function, which you can use to insert weld symbols for existing
welds. The function is also available in the context menu for welds.

n Both the Free weld seam symbol and the Annotate weld seam function are also available under 3-
D Dimensioning + Text >Symbols.
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Referencing

Path for referenced parts

The Path for referenced parts function in the Drawing > Extras > Temporary settings menu is no longer available.
To change the path for referenced parts, open the settings in HiCAD and adjust the folder for the L: identifier under
Directories. Then restart HiCAD to make the changed setting effective. The change is specific to the respective work-
place and may additionally have to be carried out at all other workplaces.

Internally referenced parts in externally referenced parts

When working with drawings that contain internally referenced parts within externally referenced parts, the beha-
viour when making changes to internally referenced parts has changed:

n If the internally referenced part is changed, its identical part is updated and both the identical part and the
externally referenced parent part will be identified as a changed part.

n The exception to this is if the externally referenced part is locked against processing. In this case, the identical
part will not be updated and not be identified as a changed part. In addition, a message will appear, indicating
that the part could not be updated and therefore two different versions of the internally referenced part now exist
in this drawing:
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Miscellaneous

Projection grid

The Projection grid function in the context menu for processing planes is no longer available.

Purchased and factory standard parts

Previously, it was not possible to incorporate assemblies and parts with subordinate parts from the Purchased/Fact-
ory standard parts catalogue. As of HiCAD 2022, this is now supported.

This means that, in addition to assemblies, for example, Sheet Metal parts stored in the Purchased/Factory stand-

ard parts catalogue can now be incorporated into the drawing using the Purchased/Factory standard parts
function. However, it should be noted that these Sheet Metal parts are combined into a solid during installation. This
means that the installed part will no longer be considered a Sheet Metal part from the HiCAD point of view!

When saving your own factory standard parts to the Purchased/Factory standard parts catalogue, please note the
following:

n If you work with your own tables, make sure that these tables are assigned to the Purchased/Factory standard
part category. You assign this when creating the table.

n The fitting position must be defined in the parts stored in the catalogue (.KRA files). To do this, you define a Fit-
ting CS. This consists of 3 special points which are automatically assigned the point designations #1 for the ori-
gin, #2 for the X-direction and #3 for the Z-direction.

n
To save the parts, use the Reference part, Save, Detail drawing function.
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Catalogue Editor

Service Pack 2 2022 (V 2702)

User-defined bolts+screws SFS SFS Intec TDBL-T-10,6X23
The catalogue has been extended with screws of type SFS Intec TDBL-T-10,6X23.

You can find the corresponding screws at Factory standards > User-defined fasteners > User-defined bolt-
s+screws > SFS > TDBL.
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Service Pack 1 2022 (V 2701)

Preview images - Hole patterns
The preview images for hole patterns at Factory standards > Hole patterns have been improved.

Agraffes and Filleted squares - Left: before HiCAD 2022 SP1; Right: as of HiCAD 2022 SP1
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Major Release 2022 (V 2700)

ISD templates for thread-cutting screws
As of HiCAD 2022 ISD templates for the following screws are available:

n Hexalobular socket pan head drilling screw

n Hexalobular socket oval head drilling screw

n Hexalobular socket hexagon head drilling screw

n Hexalobular socket countersunk head drilling screw

n Hexalobular socket cheese-head self-tapping screw

Each template includes a table file (.IPT) and a KRA file with a predefined and parametrically designed 3-D part on
which the table is based. The files are located in the HiCAD subdirectory KATALOGE > WERKSNORMEN (Cata-
logues > Factory standards). In the Catalogue Editor, you can find the tables at Factory standards > User-defined
fasteners > User-defined bolts+screws > Templates.

n ISD_VORLAGE_FLACHRUNDKOPF-BOHRSCHRAUBE_INNENSECHSRUND.IPT
ISD_VORLAGE_FLACHRUNDKOPF-BOHRSCHRAUBE_INNENSECHSRUND.KRA

n ISD_VORLAGE_LINSENKOPF-BOHRSCHRAUBE_INNENSECHSRUND.IPT
ISD_VORLAGE_LINSENKOPF-BOHRSCHRAUBE_INNENSECHSRUND.KRA

n ISD_VORLAGE_SECHSKANT-BOHRSCHRAUBE_INNENSECHSRUND.IPT
ISD_VORLAGE_SECHSKANT-BOHRSCHRAUBE_INNENSECHSRUND.KRA

n ISD_VORLAGE_ZYLINDERKOPF-SCHNEIDSCHRAUBE_INNENSECHSRUND.IPT
ISD_VORLAGE_ZYLINDERKOPF-SCHNEIDSCHRAUBE_INNENSECHSRUND.KRA

n ISD_VORLAGE_SENKKOPF-BOHRSCHRAUBE_INNENSECHSRUND.IPT
ISD_VORLAGE_SENKKOPF-BOHRSCHRAUBE_INNENSECHSRUND.KRA

You can use these templates as a basis for your own standards tables. To do this, you must first create a copy of the
template table.Be sure to note that various template tables are assigned dependencies on other tables, e.g. threads
or countersinks. When copying such template tables, you must also assign these dependencies to the copy. Other-
wise, problems may occur with the insertion of boltings.

When copying a table template, a copy of the corresponding KRA file is automatically created. You can then add
more data records to the copy of the table. Or you can use the respective KRA file to define individual bolts and
screws.
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Delete table columns
It was already possible to insert new columns into tables from the Factory standards catalogue. However, the dele-
tion of columns was blocked. As of HiCAD 2022, the deletion of table columns is now also supported.

However, deleting table columns only applies to customer tables in the Factory standards catalogue,
i.e. not to tables supplied by the ISD Group.

Versioning of catalogue data
If a data record of a table is changed, this leads to the fact that standard parts already installed in a drawing and
based on this data record differ from newly installed standard parts based on the changed data record. To prevent
legacy data from changing - especially in referenced models - it is possible from HiCAD 2022 to version data records
in catalogue tables.

The function is only available if the table contains a PREV_ID (Data type: Integer). There are two ways to insert the
column:

n Open the corresponding table in the Catalogue Editor and - if it does not already exist - insert a column with the
name PREV_ID (Data type: Integer).

or
n Use the function Prepare tables for versioning in the context menu of the table.

If the tables contain the column PREV_ID, proceed as follows for versioning:

n Open the table.

n Then right-click on the record you want to change and select the function New data record version. The original
data record then receives the status Deleted . The ID of the original data record is automatically entered in the
PREV_ID column of the new data record. This establishes the link between the two data records.

n Edit the new data record and save the changed table.

The modified table is available in HiCAD after a restart or after executing the HiCAD function Settings > Catalogues
> Reload. The procedure in HiCAD is then as follows:
n If a drawing contains "old" standard parts, i.e. standard parts that were installed on the basis of the original data

record, these remain unchanged.
n If new standard parts are installed, the changed data are used.
n The standard parts receive the same item number.
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An example:

As an example, let us consider the table Tifas Blind rivet, large dome head (for reasons of clarity, the columns Cus-
tom1 to Custom5 have been hidden in the following illustrations)

We want to create a new version of the data record with the ID 1 and change it.

For this we proceed as follows:

1. Create column PREV_ID

To do this, right-click on a column heading of the table and select the function New column. In the dialogue win-
dow, enter the name PREV_ID and select Data type: Integer. Then exit the window with OK.
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2. Create new data record version

Now right-click on the first column of the row with the number1 and select New data record version.

The original data record is given the status Deleted . The ID of the original data record is automatically entered
in the PREV_ID column of the new data record. This establishes the link between the two data records.
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3. Edit data record / Save table

Now edit the new data set and save the table.

Now let's look at a drawing in which the standard part was already installed before the change made above.

If the catalogue is reloaded and the standard part of type TIFA-BLI_RIVET - 3.2x10 is installed again, the changed
data will only be used for this part. The previously installed standard parts remain unchanged. But all standard parts
of this type receive the same item number.

Important:
If the original data record is deleted with the Delete record function, this record cannot be restored any
more!
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EJOT - New fasteners and consoles
The HiCAD catalogues for factory standards have been expanded to include more fasteners and fixing consoles
from Ejot and some of the existing tables have been replaced.

The old tables that have been replaced by the new tables are marked with the symbol in the catalogue.

Factory standards > User-defined processings > User-defined bores > Ejot

Tables IPT file New Replaced

EJOT bores EJOT_BOHRUNG

Centring sleeves EJOT HUELSEN_FUER_EJOT_HB

Factory standards > User-defined processings > User-defined countersinks > Templates

Tables IPT file New Replaced

Conical countersink with lowering VORLAGE_SENKUNGEN

Conical countersink VORLAGE_KEGELSENKUNG

Factory standards > User-defined fasteners > User-defined dowels > Ejot

Tables IPT file New Replaced

SDF-KB ISD_EJOT_SDF-KB_N

SDF-S ISD_EJOT_SDF-S

SDP-KB ISD_EJOT_SDP-10G_N

SDP-S ISD_EJOT_SDP-S

Sieve sleeve ISD_EJOT_SIEBHUELSE
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Factory standards > User-defined fasteners > User-defined bolts+screws > Ejot

Tables IPT file New Replaced

JA3-LT EJOT_JA3-LT

JF3 EJOT_JF3

JF3-LT EJOT_JF3-LT

JF6 EJOT_JF6

JT3-2 EJOT_JT3-2_N

JT3-6 EJOT_JT3-6_N

J3-LT EJOT_JT3-LT

JT4-3H EJOT_JT4-3H_N

JT4-4 EJOT_JT4-4

JT4-6 EJOT_JT4-6

JT4-FR EJOT_JT4-FR_N

JT4-LT EJOT_JT4-LT

JT4-LT-XT EJOT_JT4-LT-XT

JT4-S EJOT_JT4-S

JT4-STS EJOT_JT4-STS

JT4-XT EJOT_JT4-XT

JT6-12 EJOT_JT6-12

JT6-2 EJOT_JT6-2_N

JT6-2H-Plus EJOT_JT6-2H-PLUS

JT6-6 EJOT_JT6-6_N

JT9-2 EJOT_JT9-2

JT9-3H EJOT_JT9-3H_N

JT9-4 EJOT_JT9-4

JT9-6 EJOT_JT9-6

JT9-FR EJOT_JT9-FR_N

JZ3-ZT EJOT_JZ3-ZT_N

SDF-KB EJOT_SDF-KB
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Tables IPT file New Replaced

SDF-S EJOT_SDF-S

SDP-KB EJOT_SDP-KB

SDP-S EJOT_SDP-S

Factory standards > Series > Roof Wall Facade > Special profiles > Ejot

Tables IPT file New Replaced

Support profiles TRAGPROFILE_EJOT

Factory standards > Purchased/Factory standard parts > Insulation holders > Insulation holders Ejot

Tables IPT file New Replaced

Insulation holders EJOT DAEMMHALTER_EJOT

Factory standards > Purchased/Factory standard parts > Sleeves > Centring sleeves EJOT

Tables IPT file New Replaced

Centring sleeves EJOT HUELSEN_FUER_EJOT

Factory standards > Purchased/Factory standard parts > Shear connector cartridge > Ejot

Tables IPT file New Replaced

Mortar cartridge Multifix USF EJOT_MOERTELKARTUSCHE_MULTIFIX_USF

Mortar cartridge Multifix USF
Winter

EJOT_MOERTELKARTUSCHE_MULTIFIX_
USF_WINTER

Factory standards > Purchased/Factory standard parts > Wall consoles > Ejot

Tables IPT file New Replaced

CF Console 1 EJOT_CF_KONSOLE_C1

CF Console Mouse EJOT_CF_KONSOLE_MOUSE

Powerkey EJOT_KRAFTSCHLUESSEL
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Point clouds

Service Pack 2 2022 (V 2702)

Plane from points - orthogonal to a plane, parallel to a direction
The only reliable criterion when processing point clouds is the Z direction of the world coordinate system. Therefore,
in most cases, a processing plane is required when constructing a point cloud, which fits the object as well as pos-
sible, but does not have an angle - even if the point cloud itself has an angle, e.g. due to inaccuracies.

To create such processing planes, the function Plane from points has been extended. In the Parallel and
Orthogonal mode, you can now select either a plane or a direction. The dialogue window has been extended accord-
ingly:

With this extended window, planes for the following use cases can now be realized as follows:
n Mode: Parallel, Plane: XZ-plane or
n Mode: Orthogonal, Plane: Z-axis
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Example:

Let us assume that you want to attach further elements at the points (1), (2), and (3). The World CS is active.

Then you will select the processing planes as follows:

(1) Mode: Parallel, Plane: XZ-plane

(2) Mode: Parallel, Direction: Z-axis

(3) Mode: Orthogonal, Direction: Z-axis
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Service Pack 1 2022 (V 2701)

No Point Cloud license
If no licence for the Point Cloud module is active when opening a drawing file with point clouds, the following mes-
sage appears:

The message disappears automatically after a few seconds, but can also be terminated with OK.
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Major Release 2022 (V 2700)

Clipping
With the release of HiCAD 2022, working with clipping boxes has changed, which is also reflected in the changed
Point Cloud Ribbon:

The new and changed functions:

Edit clipping box

When inserting a point cloud, a clipping box is automatically created that completely encloses
the point cloud. This box can be scaled, moved and rotated using the Edit clipping box function.
The box cannot be deleted and no further clipping boxes can be created. The old "Create clip-
ping box" function is no longer available.

Subtract

This new function can be used to create one or more subtractions in the clipping box and thus
temporarily "cut away" areas of the point cloud.

Edit subtractions

This function allows you to move, rotate and scale subtractions.

Delete subtractions

This function deletes subtractions.
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The possibility of working with subtractions has made the old "Toggle clipping box" function obsolete. It is therefore
no longer available.

(1) Point cloud with automatic clipping box, (2) and (3) Processed clipping box and result, (4) and (5) Definition of a subtraction

and result

Please note:

If a drawing created with an earlier HiCAD version is loaded with point clouds, the following will happen:

n If no clipping box is defined in the drawing, then a correspondingly large box is automatically created.

n If several clipping boxes are defined in the construction, then these are retained. These boxes can then be
removed with the Delete subtraction function except for one of the boxes.
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Select processing plane via points
By averaging different points of a point cloud (e.g. a wall) you create a processing plane with the new Plane from

points function. You can choose the alignment of the plane freely, parallel to the plane or orthogonal to the
axis.

To select the points for the plane, call the function. The point selection is active in the Free mode and
the points are added to the list after selection. If you want to remove a point from the list, right-click on it and choose

Remove from list .

As soon as you have selected more than three points, not all points have to lie exactly on the averaged plane. The
Maximum deviation is the largest distance that one of the selected points in the list has to the plane. The Average
deviation is the averaged value, i.e. the sum of all deviations of the points divided by the number of points.

The following options are available for aligning the plane:

Free As soon as you have selected
three points, the plane will be dis-
played. By selecting further points
you change the position of the
plane, since the distance to each
other is recalculated after each
further point.
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Parallel to
plane

In this mode, you first select a ref-

erence plane . The usual
HiCAD selection for processing
planes is available to you in the
process. Now enter at least 2
points for the new plane. Then the
average distance of the points to
the new processing plane will be
determined and the plane will be
displayed.

Orthogonal
to axis

Here you first select the direction

to which the plane is to be
created at right angles (90
degrees). You can determine the
direction by points, an edge e.g.
of an existing part or by selecting
the X, Y or Z axis. The points for
the new plane will then be aver-
aged again.

If you have entered all the required data, the plane is applied by selecting Apply or by clicking the middle mouse but-
ton. In contrast to OK, the dialogue window remains open. This way you can create more planes.
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Please note:

When determining further points for the new working plane, the position changes. The position of the plane res-
ults from the averaged points.

(1) Direction (X axis) and 2 points

(2) Direction and 2 points identical to (1) plus third point
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Feature Technology

Service Pack 2 2022 (V 2702)

Parameterise part attributes

The function Parameterise part attributes has been further expanded.

n The attributes in the dialogue window are now displayed in groups, e.g. System attributes, Properties, User-
defined attributes, etc. This provides a clearer overview.

n As with line types, edge colours can now also be parameterised.

If you want to parameterise the edge colour, for example, enter either the colour number or a variable, e.g. EC
(for Edge Colour), as a constant formula. When using variables, please note that they must be defined before-
hand.
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You can see which colour has which colour number in the Colour Editor. The colour number of the selected col-
our is displayed below the colour list, e.g.:

Please note:
The edge colour of a part, the line type and the layer can also be parameterised. However, this only applies if the
corresponding checkboxes are active in the Configuration Editor at System settings > Referencing. This also
applies to non-referenced parts!

n For referenced parts the settings that are set in configuration management at System settings > Referencing >
Updating are taken into account as of SP2. This means that the settings defined under Synchronization of
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attributes are not only taken into account when updating referenced parts, but also when parameterising part
attributes of referenced parts. For referenced parts, only those attributes are offered that are transferred with the
part via referencing. Otherwise, the attributes that are transferred with the superordinate assembly are added.

A simple example:
The attribute number per part is to be adjusted for referenced parts only for secondary parts. The table in con-
figuration management has been changed accordingly.

When the Parameterise part attributes function is then called for a referenced part, the attribute Qty. per part is
not available, so it cannot be parameterised.
However, if the referenced part contains, for example, a non-referenced sub-part, then the attribute can be para-
meterised for this auxiliary part and, for example, also for the superordinate assembly.

Please note:
If a part with parameterised attributes is subsequently referenced, the parameterisation can become invalid. In
this case, the respective attribute - provided you have editing rights for this attribute - is calculated and set, but
the parameterisation is lost.
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New function cat_item_id(...)
With cat_item_id a new 3-D function is available in the Feature area. The function searches a table in the catalogue
for any criteria and returns - contrary to the item_id function - not the row index but the Record ID of the first entry
found as the result.

Syntax

cat_item_id('table';('column';'value');('column2';'value2');...)

catalogue_item_id('table';('column';'value');('column2';'value2');...)

The first parameter is the internal name of the table to be searched in the catalogue. You get this by right-clicking
the desired table in the Catalogue Editor and selecting the entry Change alias name in the context menu. The
internal name of the table is then displayed in the Entry field in the dialogue box that appears. You can then close
this dialogue by clicking on the Cancel button.

An example:

As an example, consider the table displayed.

Formula Result

cat_item_id('DIN_158_I';('DN';12)) 40

cat_item_id('DIN_158_I';('DN';12);('TYPE';'K');('P';1.5)) 43

item_id('DIN_158_I';('DN';12)) 5
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Service Pack 1 2022 (V 2701)

Icons for features adapted
For individual functions, there were previously differences between the icons in the feature and in the menu bar.
The icons from the menu bar are now also used in the feature.

Dependent part for internally referenced parts
In addition to externally referenced parts, from HiCAD 2022 SP1 you can also derive dependent parts from internally
referenced parts.

(1) Internally referenced part, (2) Dependent part

(3) Colour of internally referenced part changed

(4) Feature for dependent part recalculated

Dependent part for internally referenced parts
From HiCAD 2022 SP1 you can now also create dependent parts for internally referenced parts.
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Parameterise part attributes

As of HiCAD 2022 SP1, you can also call the Parameterise part attributes function via the feature log.

If the feature log already has a Set attributes entry for the part attributes, you can either modify the existing one or
create a new feature.

What's new? 123 / 290

News Overview

../Feature/AttributeParametrisieren/attribute_parametrisieren.htm


In the dialogue, the Value has been added to the Formula column. The value comes first and is the evaluation of the
formula. If you change the formula, the value is updated. With a click of the right mouse button you call up the For-
mula Editor.

Furthermore, the following parameterisable properties have been added:

n Colour of the part,

n Layer,

n Line type,

n Material,

n Usage, and

n Weight.

For the parameterisation of the attributes Material and Usage, the respective entries Catalogue and ID must be para-
meterised. These IDs correspond to the unique assignment in the catalogue.

n Catalogue: Corresponds to the Catalogue ID

n ID: Corresponds to the Item ID

User-defined system attributes

If the user has entered own/additional attributes in the catalogue at System settings > System attributes, these are
also listed in the dialogue
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Major Release 2022 (V 2700)

Parameterise part attributes
As of HiCAD 2022, it is also possible to parameterise part attributes such as Article number, Quantity 1 or the Devel-

opment width via formulas using the function Parameterise part attributes .

The parameterised attributes can still be changed afterwards via the function Part attributes, but will then be over-
written again when the feature is recalculated.
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Deselect feature steps
If one or more feature steps are selected in the feature area of the ICN, these can also be deselected in analogy to
the behaviour in other places by clicking on an empty area of the Graphic window.

Support of multi-line formulas
In the Formula Editor, it is now possible to enter formulas in multiple lines. This has no influence on the calculations
performed, but complex formulas can be entered much more clearly this way.

An example is a formula that takes on a different value depending on the value of a variable. In a single line, this for-
mula would look as follows:

ext_cutout_top_first_type='Type 39'?26:(ext_cutout_top_first_type='Type 48'?49:
(ext_cutout_top_first_type='Type 51'?49:(ext_cutout_top_first_type='Type 58'?72:
(ext_cutout_top_first_type='Type 2351'?49:500))))

Split into several lines, it would look like this:

ext_ cutout_ top_ first_ type = 'Type 39' ? 26: (
ext_ cutout_ top_ first_ type = 'Type 48' ? 49: (
ext_ cutout_ top_ first_ type = 'Type 51' ? 49: (
ext_ cutout_ top_ first_ type = 'Type 58' ? 72: (
ext_ cutout_ top_ first_ type = 'Type 2351'? 49: 500
))))

To do this, line breaks can be inserted in the formula editor using the SHIFT+ENTER key combination.

In addition, the size of the Formula Editor window can also be changed vertically to be able to display formulas with
many lines completely. Furthermore, the keyboard can be hidden and shown again via the arrow symbol next to the
text input field or via the key combination Alt+Page Up or Alt+Page Down.
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Hole pattern: Number of holes
For Hole patterns that were created using the same-named function, the Number of holes attribute is now dis-
played in the feature entry, indicating how many holes were created by this hole pattern. Holes that were only par-
tially created (e.g. because they are located on the border of the processing area) are counted as normal.
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HCM

Service Pack 1 2022 (V 2701)

Part HCM constraints - point options for parts below sub-assemblies
When defining constraints with the 3-D Part HCM you can now also use the desired point options for different parts
below a sub-assembly. The example below shows a Sheet with flange, Point option M2 in connection with the func-
tion Coincidence.
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Top: Selection of geometry (1) with use of point option M2 at (2) + (3)

Bottom: Result after using point option (4)
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Sketch HCM

The context menus of the Sketch HCM have been optimised. In the Tools sub-menu, the functions Chirality
and Half-space specification have been removed.

For angle and distance constraints, the function Reverse dimension direction is available in the Smart
dimensioning sub-menu instead. The function can only be applied to angle and distance constraints and is also
available in the corresponding context menus (right click on a constraint).

In the following example, the dimension direction has been reversed for the dimension 80.
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For tangential constraints, the Reverse orientation function is available in the context menu of the con-
straint.
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Major Release 2022 (V 2700)

Preferred snapping of HCM and parametric dimensions
Thus far, if an HCM or a parametric dimension was displayed directly above a part of the drawing in the drawing
view, the system preferentially snapped the geometry behind it when clicking. This behaviour has now been
changed so that the HCM or parametric dimension will now be preferentially snapped in this situation.

Top: Behaviour before HiCAD 2022: The profile was snapped.

Bottom: Behaviour since HiCAD 2022: The HCM dimension is snapped.
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Display of directed distances in the ICN
The display of directed distances in the ICN has been redesigned so that directed distances together with their dir-
ection can already be identified by the icon and its description (Example: Directed Y-distance). Thus, it is no longer
necessary to expand the entry of a dimensional constraint just to see whether and to which axis this distance is par-
allel.

Additionally, this display is now identical between the Part HCM and the Sketch HCM (both planar and 3-D
sketches).

Part HCM: Reverse dimension direction
For undirected distance constraints in the Part HCM that refer to a plane (for example, the distance of a point to a
surface), the Reverse dimension direction function can now be used. Your result matches the result you can
achieve by reversing the algebraic sign of the distance.

For already assigned dimensional constraints that fulfil the prerequisites, you can also find the Reverse dimension
direction entry in the context menu.
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Likewise, for constraints of the Equal distance type, the dimension direction can also be reversed via the context
menu. In this case, the shift affects the distance that was selected in second place when the constraint was
assigned.

It should be noted here that reversing the dimension direction can produce unexpected results if neither of the two
distances is further defined.

Deselect HCM constraints
If one or more HCM constraints are selected in the HCM area of the ICN, this selection can now be deselected ana-
logously to the behaviour in other places by clicking on an empty area of the graphics window.
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Automatically generated HCM conditions for N-Gons
The revised N-Gon function behaves differently depending on whether the automatic creation of positional con-
straints is active or not: If activated, in addition to the lines of the N-Gon, a circle will be generated as auxiliary geo-
metry, which depicts the selected radius of the N-Gon (depending on the selection either the width across flats or
the corner dimension). This is linked to a group constraint,together with the lines of the N-Gon. Thus, by changing
the radius of the circle, the radius of the N-Gon can be changed easily.

Automatically generated coincidence constraints for the point option O
The behaviour of the Point option O has been changed, which also affects the generation of HCM constraints when
the automatic generation of HCM constraints is active:

If you use the point option O to identify either the centre of a circle or an arc, or a start point of an arc, a coincidence
constraint will now automatically be generated on the underlying line. However, this does not affect points which
"only" lie on a circle or an arc.

"Use external references" button in the HCM area of the ICN
Similar to the Feature window in the ICN, a button for activating or deactivating the Use external references function
is now also available on the HCM tab.
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New HCM constraint "Group" (Sketch HCM)

The new HCM constraint Group is now available in planar and 3-D sketches. It can be used to combine two or
more graphical elements into a group, which can then only be moved together by the HCM.

After calling the function via Sketch > HCM > Coincidence > Group, HiCAD prompts you to select the graphical ele-
ments you want to add by clicking on them one after another. You also have the option to select Lines in rectangle or
Connected lines or edges via the context menu. Additionally, you have the option to add All lines of the sketch to the
group. After completing the selection via the middle mouse button, the group will be created and HiCAD will prompt
you to select graphical elements for an additional group. Pressing the middle mouse button without having selected
graphical elements will terminate the function.

Only one symbol for coincidences between a line and a point
If there was a Coincidence constraint between a line and a point in the drawing, then the coincidence icon was dis-
played both at the point and at the line. It often happened that the icon covered the line. This has now been changed
so that the coincidence is only displayed at the point.

Coincidence icons before function redesign
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Coincidence icons after function redesign
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Configuration Management

Service Pack 2 2022 (V 2702)

Rearrange dimensions and annotations
In the Configuration Editor, the settings for production drawings have been extended. New is the parameter
Rearrange dimensions and annotations under PDM > Drawing Management > Production drawings.

This parameter can be used to specify whether dimensions / annotations that have been manually created or
arranged during drawing management are to be rearranged when the drawing is updated. The ISD default setting is
Yes.

Allow markings on polygon model
As of HiCAD 2022 SP2, the parameter Allow markings on polygon model is always active. For this reason, the cor-
responding checkbox under Modelling > Miscellaneous has been removed. The parameter ensures that the selec-
ted surfaces are highlighted in colour while transforming surfaces (3-D Standard > Tools > Surface).
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Transfer of the SKIZZTEC.DAT into the Configuration Editor
The settings from the SKIZZTEC.DAT file have now been integrated into the Configuration Editor (ISDCon-
figEditor.exe).

You will find the entry of the DAT file in the following directory:

n System settings > Sketches > Grid, 2-D sketching functions

3-D annotation with interruption of lines and hatchings
As of HiCAD 2022 SP1, under System settings > Annotations > Part annotation in the Configuration Editor, you can
set whether the lines of parts and hatchings behind a 3-D annotation should be interrupted in the HiddenLine rep-
resentations. If the option Interrupt background lines is active, hatchings and lines will be hidden. Please note that
this option is read in when HiCAD is started and is active by default. Changes will only take effect after a restart.
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Display and editing of existing articles during isometry and pipe spool drawing generation
The entry Show pipeline article for editing was added to the Configuration Editor under Plant Engineering >
Isometry and Pipe Spool Drawing. It controls whether the article master mask will be displayed in HiCAD or not.

If the option is active in the Configuration Editor and you now activate the function for automatic generation of
drawings / pipe spool drawings in HiCAD and select the Link document option in the mask, as well as the pipelines
to be derived, then the article master mask will be displayed for each pipeline that was ticked off and can be adjus-
ted.
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This step happens before the actual drawing generation. This means that the changed values are also transferred
directly to the respective drawing.
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Steel Engineering settings - Default material
The setting Steel Engineering > Default material is no longer available in the Configuration Editor. The previous set-
ting was only used in HiCAD for the following functions:

n

Prototype beam ,

n
Beam from sketch and

n when importing steel plates via the SDNF Interface. Here, the default material was only used if a plate also exis-
ted for the selected default material in the catalogue table Semi-finished products > Plates > Plate.

S235JRG2 is now taken as the default material. For the functions Prototype beam and Beam from sketch this
applies to the first call in a HiCAD work session. For further calls of the function, the last selected material will be pre-
set.

The selection of the default material is also no longer available on the Weight calculation tab of the Steel Engin-

eering > Settings function.
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Treat regular parts like assemblies
In the Configuration Editor there is the new compatibility option Treat regular parts like assemblies that can be
found under Compatibility > Itemisation. If this option is ticked off, regular (BOM-relevant) parts will be treated like
assemblies during the itemisation in HiCAD and their sub-parts will become separately numbered sections. The pre-
requisite is that you have to select the By assemblies mode in the itemisation settings on the General tab.

(1) Do not treat regular BOM-relevant parts like assemblies

(2) Treat regular BOM-relevant parts like assemblies
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Major Release 2022 (V 2700)

KRPMOD.DAT settings moved to Configuration Editor
The settings from the KRPMOD.DAT file have now been integrated into the Configuration Editor (ISDCon-
figEditor.exe).

You will find the entries of the DAT files in the following directories:

n Modelling > Surface/Edge functions

n Modelling > Miscellaneous

n Modelling > Part creation > Extruded and revolved parts

Autopilot settings
The display of usable options for the autopilot in the Configuration Editor has been revised: Instead of entering letter
abbreviations in a text field, the individual option can now be selected and deselected via a checkbox.
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New data format for annotations
With HiCAD 2022, the internal data format of annotations has changed. During the creation of new annotations (also
in drawing derivations and sheet developments), the new format is always used. Visually, there are no differences to
the "old" format. When loading a drawing that contains annotations created before HiCAD 2022, a prompt for con-
version appears.

In the ISD Configuration Editor, under Compatibility > Annotations > Part annotation, 3-D, you can preset how to
proceed when constructions with "old" annotation tags are loaded and whether a message should be output after a
conversion.

The conversion of old annotation tags can also be done automatically by setting the Convert part annotations of the
drawing when loading? parameter to Yes, without query.

Start grid length when using the 2-D sketching tool
The Factor for distance cursorentry from the SKIZZTEC.DAT has been moved to the Configuration Editor. Here,
under System settings > Sketches > 2D sketch grid, you can now specify the Grid distance as a percentage of the
graphics window height and the screen resolution. For example, if you select a point with the 2-D function Polyline

(2-D Geometry > Draw) and then move the mouse, the distance is displayed at the cursor.

Units
Decimetres can now also be preset for the surface and surface area unit. For this purpose, the selection box in the
Configuration Editor under System settings > Units has been extended accordingly.
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Processing standard when loading legacy data
The new entry

n Activate the new option Processing standard when loading the itemisation settings from legacy data (System set-
tings > Itemisation > Migration)

can be used to specify the value to be entered when loading legacy data for the Processing standard option intro-
duced in HiCAD 2021 (2600.0). Up to now, the option was always activated when loading legacy data.

Changed structure of parameters in Configuration Editor
In the Configuration Editor, the structure under PDM > Drawing Management > Production drawings has been
changed. The parameters for generating drawing numbers have been combined in a separate section.

Projection grid
The Projection grid function in the context menu for processing planes is no longer available.
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IFC export - Reference view
For the interface version IFC4, the export as Reference View is also supported for the IFC export from HiCAD 2022
onwards. For this purpose, the Model View Definition setting is available in the dialogue window for the IFC export.
However, this is only visible if you have selected IFC4 as the interface version under Interfaces > IFC in the Con-
figuration Editor.

Navisworks export
Export to Navisworks was previously only possible via the HiCAD API. As of HiCAD 2022, drawings and parts can
also be exported to NCX and NWD formats using the 3-D formats (STEP, IFC, 3D PDF...) function. Please note that
exporting as an NWD file is only possible if a licensed version of Navisworks is available on the computer.

The settings can be preset under Interfaces> General 3-D interfaces and Interfaces > Navisworks in the Con-
figuration Editor.

What's new? 147 / 290

News Overview

../../../hicadsst/Content/StahlbaublechSchnittstellen/IFC.htm
../../../hicadsst/Content/3D-Schnittstellen/navisworks.htm
../../../hicadsst/Content/konfig.htm


Bill of Materials / Report Manager

Major Release 2022 (V 2700)

Output of installation surface and installation width
In the BOM template HiCAD_Stahlbau.2700.xlsx the tables Packaging list and Packaging list 2 have been extended
by the output of the installation length (the variable DWF_COVER_WIDTH ) and the installation surface (DWF_
UNCUT_PROFILE_AREA).

Steel Engineering Excel template: Image next to header data
In the BOM template HiCAD_Stahlbau.2700.xlsx the new output formats Sheet Metal parts with image 2 and Pack-
aging list 2 have been added. These differ from the previous outputs in that here the images of the parts are dis-
played next to their header data:
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These outputs are disabled by default. You can activate them by opening the file HiCAD_Stahlbau.2700.xlsx in the
sys directory of your HiCAD installation and setting the value of the Create column to true on the Settings work-
sheet for the desired other Excel sheets:
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Variant Editor

Service Pack 2 2022 (V 2702)

Search and replace in variants
A variant is described by various attributes, some of which are identical or almost identical for all sub- types.
Examples of this are the file name or the order note.

In practice, it can happen that a series of attributes must be changed in several variants. In this case, it would be
very time-consuming to open and adjust each variant individually.

In this case, the Variant Editor offers the possibility of searching several variants for an attribute and replacing the
current value with another one.

The Search & Replace is done via the command line call of the Variant Editor with the call parameter searchAndRe-
place. This is used as follows:

VariantenEditor.exe /searchAndRepalace path\search_parameters.txt path\list_of_variants.txt

Two files are required for the call:

n search_parameters.txt

This file contains control and search parameters and must be in TXT format iUTF-16 Little Endian with BOM
encoding. Here you must work with a suitable text editor, e.g. Notepad ++.

Instead of search_parameters enter the name of the corresponding file. path is the complete path to this file.
More about the structure of the file can be found in the section The search_parameters file.

n list_of_variants.txt

This file contains the list of parts to be changed. It must be in TXT format, also in UCS-2 LE BOM coding. Instead
of list_of_variants, enter the name of the corresponding file. path is the complete path to this file. More on the
structure of the file can be found in the section The list_of_variants file.

If you start the Variant Editor as indicated above, it first goes through each line of the search_parameters.txt file and
reads in the attributes. Then it goes through each line of the file list_of_variants.txt to read in the parts/variants to be
changed. It checks whether the opening and reading of the files works and whether they are empty or contain all the
necessary attributes.
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If all tests are successful, a backup copy is created for each variant file. These backup copies are given the file exten-
sion .BAK. Now the editor goes through each variant step by step and searches for the attributes with the specified
values. If there is a hit, the function replaces the old value with the new one. After the last variant has been run
through, the process is automatically terminated.

To facilitate diagnosis in the event of an error, all steps are logged in a log file. The path and file name of this file are
displayed in the console at the end. The log file can be found in the temp folder of the HiCAD installation directory.

If necessary, a manual HELiOS login is required.

The search_parameters file

The file is divided into two sections.

Part 1

The first part defines the control parameters for the behaviour of the Search & Replace function. The lines have the
following structure:

Control attribute name: Value

Blank lines and lines beginning with the#character are ignored. In this way, parameters can be (de)activated quickly
and easily.

The control attribute name refers to an attribute that controls the variant change process. These are described via
attributes that begin with the prefix VAREDIT_.

Attribute Explanation

VAREDIT_
LANGUAGE_
CODE

The value for a HELiOS attribute name can be in the variant in several languages. The lan-
guage code matching the HiCAD language must be entered after this attribute, e.g. 1031
for German. 1033 for English or 1036 for French. This parameter is mandatory and is set
to 1031 by default.

VAREDIT_
BASE_DIR

Here you can specify the directory in which the variant files are located. As a rule, this will
be the path to the HiCAD PlantParts directory. This parameter is mandatory and is
assigned by default with the PlantParts folder in the installation directory.

VAREDIT_DRY This attribute can be used to control whether the variant file should actually be changed or
not. The truth value 1 pretends to browse and change the variant, but the file remains
unchanged at the end. This parameter is optional and is set to 1 by default.

VAREDIT_
REGEX

If the truth value of this attribute is set to 1, then regular expressions are included in the
search parameters. If not set, then the expressions are ignored. This parameter is optional
and is set to 0 by default.

VAREDIT_UPD_
REVID

If the truth value of this attribute is set to 1, then a HELiOS query for the revision is per-
formed for the variant. This only happens if the part's Head ID is also changed. This para-
meter is optional and is set to 1 by default.

The block ,for the control parameters could, for example, look as follows:
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# Block of control parameters

VAREDIT_LANG_CODE:1033

VAREDIT_BASE_DIR:C:\HiCAD\PlantParts\

VAREDIT_DRY:1

VAREDIT_REGEX:1

VAREDIT_UPD_REVID:1

Part 2

The second part defines the search parameters for the actual Search & Replace. The lines have the following struc-
ture:

HELiOS attribute name:Search value;Replace value

The HELiOS attribute name refers to an attribute that is used in the variants, e.g. BENENNUNG (= Designation).
Instead of a HELiOS attribute name, you can also specify a variable name directly, e.g. N instead of NENNWEITE (=
Nominal diameter).

You cannot use the language-dependent attribute identifiers displayed in the variant editor,
such as sheet thickness etc!

Spaces in the values are not ignored, but read in as written there.

The block for the search parameters could, for example, look as follows:

# Block of search parameters

CNT1:20100;10000

PN:40;50.569

D1:90;120.666

HEL_SACHNUMMER:EN 1092-1/01/DN <NENNWEITE>/PN 40;EN 1092-1/01/DN <DRUCK>/PN <DRUCK>

BENENNUNG:(Clean)[^ ]*( for welding);\1break\2

HEL_KOPFID:B00DH4XULBEB5J00003HVV;B00DH4XULBEB5J00003HLP

Floating point values (Decimal fractions9 must be separated with a point and not with a
comma!

The list_of_variants file

As mentioned above, this file lists the variants to be changed with their file name and extension. Each line may only
contain one file at a time.

Empty lines and lines beginning with the character # are ignored. Thus, variants can be (de)activated quickly and
easily.
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The content of the list of variants could, for example, look as follows:

# List of variants

EN1092-1-01-PN25.vaa

EN1092-1-01-PN40.vaa

EN1092-1-01-PN63.vaa

You can find an example in the online Help at Auxiliary Functions for Data Transfer > Search and Replace in Vari-
ants.

Take over comments from feature variables
For explanatory purposes, comments can be assigned to part or feature variables in HiCAD, which can be very help-
ful, especially if there are a large number of variables.

If parts with variables and assigned comments are saved as a VAA file, you should in any case note the following:

a. Comments that you have assigned to part or feature variables are also stored in the archive file (.VAA) when a
feature variant is created. The storage takes place in the archive in an internal IPT table.

b. If parts from a VAA file are incorporated into the drawing, the comments stored in the internal IPT table will be
used as a tooltip.

c. If the VAA file is opened with the Variant Editor, the comments will be read from the internal IPT table of the
VAA file and displayed as an editable Description. However, this does not apply to structured variants.

d. If the description is changed in the Variant Editor, this will be displayed as a tooltip during the installation of the
variant.

e. In the Variant Editor, the descriptions can again be overwritten with the comments of the feature variables. For

this purpose, the new button is available. However, this does not apply to structured variants.

The following graphic is intended to illustrate the above-mentioned points once again:
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Saddle connectors - Variable DA
For saddle connectors, the variable name DA is reserved for the outer diameter of the pipe into which the saddle con-
nector is inserted. This value is overwritten when the saddle connector is loaded. Therefore, the name must not
appear in the variable table.

For this reason, as of HiCAD 2022, there is an error message when trying to save such a saddle connector with the
Variant Editor.
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Automation

Discontinuation

Discontinuation of the ISD.PDM.API

Before carrying out a HELiOS update for an older HiCAD version, please note that from HELiOS 2022 omwards,
the previous ISD.PDM.API will be discontinued and replaced by the new API from Helios.Interface. If you use
customisations that use functionalities from the previous ISD.PDM.API, you must update the customisations to
the new API before carrying out the HELiOS update. If you use customisations that use functionalities from the
HiCAD API, you should ensure that the HiCAD version used is at least version 2502.5 or 2601.1 or newer. If you
are unsure whether you are using corresponding adaptations, please talk to your administrator or contact the
ISD in case of doubt.

Service Pack 2 2022 (V 2702)

Attach flange to surface
The function Attach flanges to surfaces, which has been completely revised in HiCAD Version 2022 SP1, can now
also be used via the API:

n Klasse ISD.CAD.SheetMetal.AttachFlange2Face

Plotter/Pen settings configuration via API
Printing via the API uses the settings from the FRD files.

For loading these files the following functions are used:

n HRESULT ReadSystemColorTable?([in] BSTR strFRDFile);

n HRESULT ReadConstructionColorTableFromSZA([in] BSTR strSZAFile); // Laden aus SZA

n HRESULT ReadConstructionColorTable?(BSTR strFRDFile);

n With HRESULT PenSettingsConfiguration?([in] LONGLONG hParentWnd); // hParentWnd kann null sein you
can edit the pen settings.

Also, new methods are available:

n HRESULT LoadPloFile?([in] BSTR strFileName, [out, retval] VARIANT_BOOL* bResult); // PLO-Datei einlesen

n HRESULT GetCurrentPloSize?([out] DOUBLE* dWidth, [out] DOUBLE* dHeight, [out, retval] VARIANT_BOOL*
bResult); // Größe abfragen

n HRESULT PrintCurrentPloFile?([out, retval] VARIANT_BOOL* bResult); // Drucken
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Inch character for macro-based functions
In general, HiCAD supports the use of the inverted comma as an inch character. An exception is the macro sub-
system, i.e. the execution of MAC files. Therefore: If you edit macros manually, you should use two inverted commas
instead of an inverted comma.
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New HELiOS.Interface
The new HELiOS.Interface is an API independent of the HiCAD API with which you can conveniently create, search
for or change objects such as projects, documents and articles. The processing of the workflow can also be facil-
itated with the API.

Macro Technique

ASK command

The new ASK command serves as a VAR substitute that additionally allows the specification of a unit category.

Currently, the following categories are supported:

NUM -> Category::Scalar

Number of indeterminate dimension, e.g. plotter speed.

LENGTH -> Category::Length

A length

SCALE -> Category::Ratio

A scale

Examples: As used by views; scale factor of an affinity

FACTOR -> Category::Scalar

Something with which an existing value is to be multiplied.

Examples: Factor to a measure (subroutine maszafak);

Magnification factor; width factor for texts

ANGLE -> Category::Angle

An angle

FRACTION -> Category::Ratio

A fraction

Examples: Fraction of specular reflection in HIDOPT; slip

LENGTH_TOL -> Category::Length

Length tolerance

MASS -> Category::Mass

Mass

AREA -> Category::Area

Surface area

VOLUME -> Category::Volume

Volume

DENSITY -> Category::Density

Density
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TIME –> Category::Time

Time

PRESSURE -> Category::Pressure

Pressure

TEXTHEIGHT -> Category::Length

Text height

DIMLENGTH -> Category::Length

Length that refers to the drawing sheet instead of the drawing.

Examples: tolpar from dimensioning; maximum length of hatching lines

INVSCALE -> Category::Scalar

Like SCALE, but inverse, currently bent to FACTOR

ANGLE_TOL -> Category::Angle

Angle tolerance

By grouping ECHO, VAR, VAI and now also ASK commands in round brackets, you can define a simple GUI in the
macro.

Konrea for macro recording

Please ensure that you always state formulas with the appropriate unit, this helps to avoid errors.

Save by bodies: Identification

The macro variable ZOID is no longer used in 3D for points, edges and facets, instead the variables ZOIP and ZOIE
were introduced. The macro variable ZNED was replaced by ZNEP and ZNEE.

You may need to extend functions from FUNC commands that pass ZOID to also pass the index of the sheet body.

Example: makro3d\formpostol_edit3d.mac: FUNC %RET:=FORMPOSTOL.EDIT3D( %ZOID ), the corresponding
function is int FormPosTolImpl::edit3d( int idxcontainer )
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Service Pack 2 2022 (V 2702)

3-D DXF export

The function 3D-DXF (Approx.) function (via Drawing > Save/Print... > Save as  > Further... > 3D-DXF
(Approx.) is no longer available as of SP2. This function only output a faceted representation, not a complete geo-
metry file! The better alternative is the real 3D DXF export or the export as 3D PDF.

2-D DXF: Taking into account of units
For both import and export of 2-D DXF files, the possibility of interpreting data in different units has been created.

By default, the units of the DXF file are interpreted during import. When exporting, the data is exported in the HiCAD
drawing unit.
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Service Pack 1 2022 (V 2701)

PROFLEX-BOMs
PROFLEX® is an ERP software for metal processing..

For the output of PROFLEX®-specific BOMs, the following functions are now available at Drawing > Save/Print.>
Save as > Further...:

PROFLEX-BOM, Entire drawing

PROFLEX-BOM, Active part

The BOMs contain certain columns of the Excel BOM for Steel Engineering (HiCAD_Stahlbau*.xlsx) that are spe-
cifically relevant for PROFLEX®. The output is in XLSX format. Generated will be the structure list and the quantity
list.

IFC import - Representation of beams + profiles
When importing beams and profiles via IFC, the default representation (exact or simplified) defined in the Steel
Engineering Settings
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function is now taken into account.

SNDF import of Steel Engineering plates
When importing steel engineering plates via the SDNF interface, the default value set on the Weight calculation tab

of the Steel Engineering Settings function was previously used. However, this only applied if a plate existed in
the catalogue table Semi-finished products > Plates > Plate for the selected default material. Only then were the
plates imported/generated. As of HiCAD 2022 SP1, S235JRG2 is used as the default material for steel engineering
plates.

Enhancements for export via Spooler
The output via the Spooler has been extended by the formats

n ToPs GEO (*.geo) and

n Navisworks (*.nwc and *.nwd); however, the export as .nwd file is only possible if a licensed version of Nav-
isworks is available on the Spooler server.

With the Navisworks export via the Spooler - as with other formats - the entire model drawing is exported.

The ToPs GEO export only exports sheet developments or developments of sheets that exist in the drawing.
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Major Release 2022 (V 2700)

Update to CADfix 12 SP2
With the update to CADfix 12 SP1, interfaces to the following format versions are now available in HiCAD 2022:

n ACIS 2021 1.0 (R31)

n CATIA V5 V5-6 R2021

n DWG 2021

n DXF 2021

n Inventor 2021

n JT 10.8

n PLM XML 10.8

n Parasolid 33

n SOLIDWORKS 2021

n NX 1953 Series

Navisworks - Export
Export to Navisworks was previously only possible via the HiCAD API. From HiCAD 2022, designs and parts can also
be exported to nwc and nwd format using the function 3-D formats (STEP, IFC, 3D PDF ...). Please note that export-
ing as an nwd file is only possible if a licensed version of Navisworks is available on the computer.

After calling up the function, select the desired file type. On the right in the dialogue window you can then specify
the options for the export.

The settings can be preset in the Configuration Editor at Interfaces > General 3-D Iinterfaces > Navisworks and
Interfaces > Navisworks.
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IFC-Import - BOM-relevance
Until now, the BOM-relevance of parts and assemblies was automatically removed when importing IFC files. From
HiCAD 2022, an additional checkbox can be used to specify whether the attribute BOM-relevant should be assigned
to the imported parts and assemblies or not.

This can be useful, for example, if a model drawing is started in a staircase program and is then to be completed in
HiCAD.
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IFC-Export - Reference View
For the interface version IFC4, the export as Reference View is also supported for the IFC export from HiCAD 2022.
For this purpose, the setting Model View Definition is available in the dialogue window for the IFC export. However,
this is only visible if you have selected the interface version IFC4 in the Configuration Editor at Interfaces > IFC.
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In this case you can select in the Model View Definition field which definition is to be used for the export as IFC data
model.

n Design Transfer View
This is the default setting for the IFC export. In contrast to the Reference View, where the exported model should
not be changed, it is possible to make changes to the exported model when exporting via IFC4 Design Transfer
View.

n Reference View
This setting assumes that the exported model is not to be changed. This makes sense if the exported model is
only to be used for pure coordination purposes, e.g. for visualisation, collision detection, quantity takeoff, etc.,
and therefore no absolutely exact geometry is required. The geometry is represented "simplified" here, i.e.
simple geometry with extrusions only, complex geometry as a tessellated polygon mesh. With this definition,
there are also fewer compatibility problems in the IFC management programs than with the IFC 4 Design Trans-
fer View.
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Sheet Metal

Service Pack 2 2022 (V 2702)

Design Variant - SZ20 Base point with projection
When using ALUCOBOND SZ 20 tray panels, a flange can now be attached at the bottom connection to which an S-
or Z-profile or a Z-fold can be automatically riveted.

This use case cannot be realized directly via the Element Installation dialogue window! Instead, a new design vari-
ant, SZ20 Base point with projection is available in the Sheet Metal sub-folder of the Civil Engineering functions
docking window. The length and angle of the flange can be configured and there are various types of insertion to
select from.
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Flanges Along Sketch On Surface

The Flanges Along Sketch On Surface function has been newly developed and replaces the previous func-
tion. With this function you can attach several flanges around a surface in one step. The flanges are derived from a
planar sketch and are chamfered taking into account the current Technology parameters.

n A preview of the flanges is displayed, which is immediately updated each time the entries are changed.

n Both edges and surfaces can be selected to determine the surface.

n Parameters such as angle, bend zone or fitting mode can be defined individually for each attachment.

n The function supports the milling edge technique.

n Corner processing / mitre can be defined for adjacent flanges.

n Instead of multiple individual features, the new function creates just one feature, which can be used to change
the flanges at any time - in a single step.

In the example displayed, the base surface of a sheet has been selected. The parameters for the attachment on the
left edge were selected individually.
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Workshop drawing - Sheet metal part as assembly main part
Previously, the drawing derivation did not support the automatic generation of workshop drawings for assemblies if
the assembly main part was a sheet metal part. As of SP2, this is now possible - but only if the assembly main part is
a cassette-shaped or profile-shaped sheet metal part. The procedure for these assemblies is thus analogous to
assemblies in Steel Engineering, which have a profile as the assembly main part. (see also Basics - What's new?)
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Service Pack 1 2022 (V 2701)

Attach flanges to surface
A completely revised version of the function Attach flanges to surface is now available for attaching flanges to a sur-
face. The new dialogue allows you to enter different parameters for each attachment. Furthermore, you have the pos-
sibility to define the corner processing directly in the dialogue. You can conveniently change the flanges in one step
at any time using the corresponding feature entry.

The choice of the first connecting edge determines the surface and thus also the direction of the flanges. If you
select a surface instead of individual connecting edges, all outer edges are taken over for the attachment. To delete
individual edges, click on the attachment in the model drawing. It will then be removed from the list.

After selecting the outer connecting edge, a preview of the new flanges is displayed, provided you have not activated
any options that require further specifications.

In the Parameters area, you make the default settings for the attachments. Also in this function you have the option
to select milling edge zones instead of cylindrical bend zones for composite sheets. Change the parameters for each
new flange in the Attachments area by selecting a Value instead of Default setting. Right-click to delete the attach-
ment from the list.

The variant selected in the Process corner area is combined with the joint. Depending on the combination, the input
of Clearance, Projection or Diameter is requested.

170 / 290 What's new?

Sheet Metal

../lascheankantenbl/lascheringsrumbl.htm


(1) Off (no processing); (2) Close corner, free / Inner edge flush; (3) Close corner,free / Proportional projection; (4) Close corner,

closed / Inner edge flush; (5) Close corner, closed / Proportional projection; (6) Close corner, closed / Outer edge flush; (7) Drain-

age area; (8) Close corner, round / Inner edge flush, (9) Close corner, round / Proportional projection

Example:
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Flanges to surface, with drainage area and clearance; flanges with different angles and lengths

Clean up intersections
The Clean up intersections function has been completely revised. In contrast to the clean up function in versions
before HiCAD 2021 SP1, the new function always processes the whole sheet metal part, not only certain flanges or
bend zones. This way a consistent operation is achieved. If it is necessary not to carry out certain clean-ups in a part,
you can exclude e.g. flanges or bend zones by selecting individual surfaces in the dialogue.

With the option Use external references for collision parts, changes to the collision part will be tracked in the future.
That is, if you change the radius of an intersecting cylinder, then after a recalculation of the Clean up intersection
feature, the subtractions will be adjusted.
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The intersection does not have to be perpendicular to the surface, it can certainly be done for lasers that cut at an
angle.

(1) Intersection parallel to the collision parts

(2) Perpendicular to surface

By default, only the largest portion of the intersected part is kept after the clean up. In case you want to keep the
small parts as well, the option can be deactivated.

Option Keep largest part only deactivated
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Examples:
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Adjusted sheet corner with stiffener
For the Design variant Sheet corner with stiffener, the flange with the stiffener will now be adjusted in case of dif-
ferent flange lengths.
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(1) Sheet corner with stiffener in HiCAD 2022 SP1

(2) Sheet corner with stiffener before HiCAD 2022 SP1
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Extensions for export via Spooler
The output via the Spooler has been extended by the format ToPs GEO (*.geo). The ToPs GEO export only exports
sheet developments or developments of sheets that are available in the drawing.

Section paths of sheet metal parts in derived drawings
The generation of the section path during the automatic drawing derivation of sheet metal parts has been optimised
in HiCAD 2022 SP1.

Example of the position of the section path with regard to the processing of outer edges

(1) Sheet metal part

(2) Automatic drawing derivation with sectional views from HiCAD 2022 SP1

(3) Automatic drawing derivation with sectional views before HiCAD 2022 SP1
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Example with extended sectional views (B - B)

(1) Sheet metal part

(2) Automatic drawing derivation with sectional views as of HiCAD 2022 SP1

(3) Automatic drawing derivation with sectional views before HiCAD 2022 SP1
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(1) In this example the sectional view is now generated

(2) Sheet metal part

Feature icons adapted
For some functions, there were previously differences between the icons in the feature and in the menu bar. The
icons seen on the menu bar are now also used in the feature log.

With HiCAD 2021, the possibility to itemise parts that are sub-parts of a sheet metal part in the part structure has
been abolished. However, this has proved to be problematic in some customer drawings. Therefore, this behaviour
has been reversed reversed in HiCAD 2022 SP1.

This means that parts that are sub-parts of a sheet metal part will now be itemised again (if they are BOM-relevant).
However, this does not apply to flanges and bend zones, which are not itemised.
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New function: Merge flanges/bend zones

The new Merge flanges/bend zones function has been developed mainly to assist you in joining different

Sheet Metal parts. For example, you can join two Sheet Metal parts with the Connect sheets function and then
merge the adjacent flanges or bend zones. The prerequisite is that the elements lie on one plane and touch each
other.

After selecting the function, the dialogue for collecting the flanges or bend zones appears. Identify the flanges to be
united by clicking near the adjacent edges. After a right-click you can select the flanges or bend zones in the ICN or
in the drawing one after the other. Multiple selection is also possible. If you want to remove a pair from the list, activ-

ate it with the right mouse button and then select Remove element(s) from list .
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When merging the pairs, the system first checks whether they can be united, otherwise an error message appears.
As the list is processed one after the other, flanges (or bend zones) can be united several times with different flanges
in one step.

(1) Bend zones 1 and 2 are merged

(2) Bend zones 3 and 4 are merged

(3) Bend zone 2 (previously merged with 1) and 3 (previously merged with 4) are merged

(4) Result
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Connect sheets

With the Connect sheets function (Further functions > Extras > ...), sheet metal parts that have been cre-
ated with the functions

n Sheet from solid

n Sheet from surface

can also be connected from HiCAD 2022 onwards. The feature log and part structure are merged during the con-
nection.

Design Variant "Sheet corner with stiffener"
In the Sheet corner Design variant, you can now insert standard parts without the stiffener.

This means that even though the stiffener and the sheet are not screwed together, the standard parts appear in the
bill of materials. To do this, combine the options Create bores only and Insert standard parts.
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Change semi-finished material in Feature log
From HiCAD 2200 it is possible to activate the semi-finished product not only via the dialogue but also via the fea-
ture log.

This allows you to change several sheets in one work step, e.g. by assigning variables for assemblies.

New data format for annotations
With HiCAD 2022, the internal data format of labels has changed. When creating new labels, e.g. for sheet metal
unwinding, the new format is always used. Visually, there are no differences to the "old" format. If you load a design
that contains annotations that were created before HiCAD 2022, a prompt for conversion will appear.

In the Configuration Editor at Compatibility > Annotations > Part annotation, 3-D you can preset how to proceed
when constructions with "old" annotation tags are loaded and whether a message is to be output after a conversion.

The conversion of old annotations can also be done automatically by setting the parameter Convert part annotations
of the drawing when loading? to Yes, without query.

Coating in sectional views with Steel Engineering plates
As with Sheet Metal parts, from HiCAD 2022 it is also possible to specify for Steel Engineering plates whether the
coating is to be marked in the sectional view or not. The marking is done by an offset edge, the so-called coating
line. The settings defined in the Configuration Editor at Drawing > Annotations > Coating line in sectional view are
used to display the coating line.
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Steel Engineering

Service Pack 2 2022 (V 2702)

Divide beam

From HiCAD 2021 onwards, the Divide along direction function is available for dividing beams + profiles.
This function covers all Divide functions available until then. For this reason, these functions are no longer available
as of HiCAD 2022 SP2. This means in detail:

n The function Divide along direction replaces the previous function Divide in the Steel Engineering Ribbon in the

function group Lengthen .

n The following functions are no longer available:

l

Divide

l

Divide beam once, flush, with clearance

l

Divide beam several times, flush

l

Divide beam several times, flush, with clearance

This also applies to the context menus.
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Cross-bracing (2603)
From SP2 onwards, the Cross-bracing (2603) Design Variant supports BESISTA tension rod systems as well as

DETAN and

Pfeifer

tension rod systems. The HiCAD catalogues Steel Engineering Standard Parts > Tensioning element and Steel
Engineering > General management have been extended accordingly.
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Strap joint (2310)

Semi-finished product for strap

From SP2 onwards, flat steels can also be selected as a semi-finished product for the Strap joint (2310) .

Fillets on welded corners of straps
From SP2 onwards, straps can also be filleted on the welded side in order to take into account the rolling radii of the
beam passing through. The Strap tab has been extended accordingly..
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Stabilizing pipe connection (2702)
In addition to the BESISTA tension rod systems, DETAN and Pfeifer tension rod systems can now also be used for
the Stabilizing pipe connection (2702).
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Staircase Configurator - Intermediate platforms
In the Staircase Configurator, it is now possible to specify for intermediate platforms whether the length of the plat-
form is to be calculated by the number of steps or by entering a value. The checkbox Calculate length by number of
steps is available for this purpose. If the checkbox is active (default setting), the length is automatically calculated
and displayed after entering the number of steps. This value cannot be edited. If the checkbox is not active, you can
determine the length by entering a value.
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Service Pack 1 2022 (V 2701)

Steel Engineering settings - Default Material
The selection of the default material is no longer available on the Weight calculation tab of the Steel Engineering set-

tings function. The previous setting was only used for the following functions:

n

Prototype beam ,

n
Beam from sketch and

n when importing steel engineering plates via the SDNF interface. Here, the default material was only used (and
the plates were only imported/generated) if a plate also existed for the selected default material in the catalogue
table Semi-finished products > Plates > Plate.

S235JRG2 is now used as the default material. For the functions Prototype beam and Beam from sketch this
applies to the first call within a HiCAD work session, for further calls of the function the last selected material is pre-
set.

Also, the setting "Steel Engineering > Default material" is no longer available in the Configuration Editor.
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Connections

Clamping plate

As of SP1, Lindapter girder clamps of type A, B and D2 are also available for fastening clamping plates.

Lindapter girder clamp Type D2
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Base plate + anchor plate (2101)

The Bore grid tab has been divided into the following sections:

n Boltings
Here the arrangement of the bolting, the hole pattern or the threaded studs on the plate is defined.
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n Fixing holes
Here you determine whether additional fixing holes are to be created that are independent of the bolting. In prac-
tice, these are sometimes needed, for example, to temporarily fix the base plate with nails when mounting the
column. In this case, determine the diameter of these holes and their horizontal and vertical distance from each
other.

(1) Bores for the boltings, (2) Fixiing holes
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Strap joint (2310)

If the connection type With stiffener is selected for the strap joint, the Galvanization tab is also available.

Galvanization tab

Here you determine whether the stiffeners are to be provided with holes for galvanization. Activate the cor-
responding checkboxes and enter the desired diameter. In addition, you can specify the minimum distance of the
holes to the flange and to the web.
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Railing Configurator

Determining the railing route

The determination of the railing route in HiCAD 2022 SP1 has changed as follows:

n First, the beam end where the railing should start is selected.

n Then the beam end must be selected that determines the direction in which the railing will be installed.

If the order of the selected beams results in only one possible walking line of the railing, then the selection of the end
of a beam is ignored.

In the example shown below, the first beam is selected at point (1), the second beam at point (2). A shows the result
before HiCAD 2022 SP1, B the result in HiCAD 2022 SP1.
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Infill with knee rails

For infills with knee rails, the "Trim to posts" checkbox on the Infill tab has been replaced by a selection box.

The additional option Trim to front edge of post is also here. This corresponds to the function Trim, to outer edge.

(1) Do not trim, (2) Trim to post, (3) Trim to front edge of post

Post - Sub-structure - Connection from bottom with flat steels

On the Post-Sub-structure tab, an additional connection variant is available as of HiCAD 2022 SP1: Connection
from bottom with flat steels.
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Post-Sub-structure - filleted and round base plates

The corners of rectangular base plates can now also be filleted. The new input field Fillet radius of corners is avail-
able for this purpose.

In addition to rectangular base plates, round base plates can now also be used.
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Post-Sub-structure - Base plates rotated 90°

If the bore with 2 holes is selected for rectangular or round base plates, it is possible to rotate the base plate 90° from
HiCAD 2022 SP1.
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Post-Sub-structure -- Lateral connection with penetration of base plate

If the connection is made with a distance element, there is now a possibility that the distance element penetrates the
base plate when connecting laterally. To do this, activate the checkbox Penetration of base plate and specify the
Clearance, the Corner radius and the Offset.

(1) Base plate, (2) Distance element, (3) Clearance, (4) Offset, (5) Corner radius
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Handrail on wall

With the Railing Configurator, handrails with wall consoles can now also be created. For this purpose, the tab Post -
Handrail has been extended by corresponding variants.

To create the wall console you must set the

n Posts,

n Infills and

n Post - Substructure constructions

to Do not create / Do not insert. In addition, a lateral offset to the handrail must be entered on the Post tab.
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Connections / Design Variants

Clamping plate

New in the Civil Engineering functions docking window at Steel Engineering > General is the clamping plate func-
tion. Clamping plates are used when parts are not to be screwed or welded. The following connections are possible:

n One plate between two beams
The clamping plates are bolted to the plate.

n One beam and one plate
The clamping plates are bolted to the plate.

n Two beams
The clamping plates are bolted to the second beam.

(A) Plate between 2 beams, the plate is drilled; (B) Beam and plate, the plate is drilled; (C) 2 beams, the 2nd beam is drilled

After calling the function, the Clamping platedialogue window is displayed.
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Zinc plating holes for galvanisation

From HiCAD 2022 onwards, only one of the zinc plating holes for galvanisation will be annotated in the workshop
drawings, and not each zinc plating hole as before. This applies to the following connections:

n Beam to web with 2 plates and stiffener (1211),

n Base plate + Anchor plate (2101),

n End plate (2102),

n Purlin joint, 2 plates with mitre cut acc. to DAST IH (2201),

n Column connection Frame corner (2203),

n Column connection Frame corner (2204),

n Front plate connection to web/flange (2320),

n Front plate connection to web, double-sided (2322) and

n Front plate connection to flange (2330).

Please note however that this principle only applies to zinc plating holes on beams, not on plates.
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Create detail drawing
With HiCAD 2012, the previously valid functionality for creating Steel Engineering workshop drawings has been
expanded to a function for general drawing derivation. For reasons of compatibility, the previously available func-
tions for Steel Engineering detail drawings continued to be available at Drawing > Itemisation/Detailing > Derive

> ... were still available. As of HiCAD 2022 (V 2700.0) the former functions for creating detail drawings are no
longer supported:

Create detail drawing

Create + print detail drawing

Use the automatism for workshop drawings to create detail drawings.

However, the remaining functions are still useful for old model drawings in some cases. Therefore, these functions
are available at Drawing > Itemisation/Detailing > Derive... > Detail drawing - Up to HiCAD 2021 in a separate
sub-menu.

Sectional views with Steel Engineering plates
As with Sheet Metal parts, from HiCAD 2022 it is also possible to specify for Steel Engineering plates whether the
coating is to be marked in the sectional view or not. The marking is done by an offset edge, the so-called coating
line. The settings defined in the Configuration Editor at Drawing > Annotations > Coating line in sectional view are
used to display the coating line.

The display of the coating line of Steel Engineering plates can also be changed subsequently. To do this, right-click
on the coating line in the corresponding view and activate the desired function in the Coating symbol context menu.

In addition, the representation of the coating lines can also be changed via the context menu for Steel Engineering
plates s if a sectional view is active. To do this, right-click on the plate in the sectional view and then select Prop-
erties > Coating line.

Grid annotation
From HiCAD 2022 onwards the functions for grid annotation can be found at 3-D Dimensioning+Text > Symbols >
Grid.
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Drawing Management

Service Pack 2 2022 (V 2702)

Rearrange dimensions and annotations
In the Configuration Editor, the settings for production drawings have been extended. New is the parameter
Rearrange dimensions and annotations at PDM > Drawing Management > Production drawings.

This parameter can be used to specify whether manually created or arranged dimensions / annotations are to be
rearranged when the drawing is updated. The ISD default setting is Yes.

Please note the following:

n By editing the model drawing, new dimension base points or annotations may be created in the drawings or may
be omitted. In such cases, it is not possible to retain the corresponding dimensions and annotations. This
means that these dimensions and annotations are always recreated when the drawing is updated and must then
be adjusted manually afterwards if necessary.

n The contents of dimensions and annotations are - if necessary - always updated.

Update only BOMs and title blocks of drawings

With the new function Only BOM and title block you update only the BOMs and title blocks of production
drawings after design changes. All other changes such as scale, dimensions, designations or new sectional views
will not be executed. However, changes to the geometry will be applied.

An example

The production drawing for the displayed drawing is created.
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Now a second plate is added to the drawing and afterwards the drawing is updated using the Drawing func-
tion.
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If the Only BOM and title block function had been used for updating, the result would look like this:
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New template file for assemblies with sub-assemblies
As of HiCAD 2022, assemblies containing sub-assemblies are considered separately when creating drawings.

If an assembly contains sub-assemblies, the new template file

BIM_WSD_Default_Superordinate_Assembly.dat

is used.

If this is not the case, then the template file BIM_WSD_Default_Assembly.dat is used as before.

The new template differs from the previous template by the setting under Part selection. The option Selection list,
without sub-parts is preset here.
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Format of manually managed drawings
When creating external production documents, the DIN format of the drawing frame is transferred to the HELiOS
attribute FORMAT from HiCAD 2022 on. For example, if your design contains a sheet area with section views in a
drawing frame of size DIN A2 and you have activated the creation of PDF files for general documents in the Con-
figuration Editor, the PDF file in HELiOS has the attribute FORMAT = DIN A2.

Changed structure of the parameters in the Configuration Editor
In the Configuration Editor the structure at PDM > Drawing Management > Production drawings has been
changed. The parameters for generating the drawing numbers have been combined in a separate section.

212 / 290 What's new?

Drawing Management

../Konfiguration/bim_config_extern.htm
../Konfiguration/bim_config_allgem.htm


Generation of drawing numbers for external documents
The drawing number generation can now also be done considering the attribute DOKUART. For this purpose, an
additional selection option is available in the Configuration Editor at PDM > Drawing Management > Production
drawings > Drawing number always depending on the drawing type:

Yes, additional manually created drawings by document type

As with the selection of Yes, the numbering is done separately for the different drawing types. In addition, however,
the generation of the drawing numbers for manually created drawings can take place depending on the attribute
DOKUART. This means that for the document types specified in the Configuration Editor at PDM > Drawing Man-
agement > External production drawings > List of manual document types for external documents, individual tem-
plates can be used instead of the template file BIM_PDM_ManualDrawingnumberGeneration.ftd.

These must be located in the HiCAD sys directory and named as follows:

BIM_PDM_dokuart_ManualDrawingnumberGeneration.ftd

Instead of dokuart the respective document type must be specified.

Example:

At PDM > Drawing Management > External production drawings > List of manual document types for external
documents the following document types are entered:

Then by creating the files:

n BIM_PDM_Example_ManualDrawingnumberGeneration.ftd and

n BIM_PDM_Cuts_ManualDrawingnumberGeneration.ftd

it is achieved that for model drawings with the attribute DOKUART=Example and DOKUART=Cuts for the generation
of drawing numbers of external documents (e.g. PDF) these files are used.
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To create these templates, proceed as follows:
n Create a copy of the file BIM_PDM_ManualDrawingnumberGeneration.ftd.

n Name the file as described above.

n Load the file, e.g. with the HiCAD function Drawing Management > Production > Attr... > Templates, Attrib-

ute assignment. Click on the Edit button next to the entry Drawing number of manual drawings.

n Load the desired file, e.g. BIM_PDM_Beispiel_ManualDrawingnumberGeneration.ftd.

n Edit it and save the changed file.
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Metal Engineering

Service Pack 1 2022 (V 2701)

New Fixing option
For boltings without sleeve an extended selection is now available on the Fixing tab of the Base plate / Top plate dia-
logue window.
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Major Release 2022 (V 2700)

Filter templates for Foil and Insulation for automatic annotations
To use annotation templates for automatic annotation, they must be assigned to parts via a part filter. In the Con-

figuration Editor, select Drawing > Annotations > Automatic annotation and click the symbol in the empty
row. Then you can select the new templates Foil and Insulation via Steel Engineering > Indiv. part, Facade Engin-
eering:
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Insertion of transparent insulations
Insulations created with the functions Insulation along sketch, Insulation from cross-section or Insulation from bor-
der can now also be created as transparent elements if desired. The Transparent option is available in the dialogue
window for this purpose.
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Element Installation

Service Pack 2 2022 (V. 2702)

ALUCOBOND® suspended - Base point: With projection
For ALUCOBOND® suspended panels, the new With projectionoption is available for connection to the Base point.
With this option, flanges can be created at the bottom of the base point, to which side flanges and a flange to the
top/bottom can be connected if required (roof box).
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The image below shows different examples:

Design Variant - SZ20 Base point with projection
When using ALUCOBOND SZ 20 tray panels, a flange can now be attached at the bottom connection to which an S-
or Z-profile or a Z-fold can be automatically riveted. The length and angle of the flange can be configured.

What's new? 219 / 290

News Overview



This use case cannot be realized directly via the Element Installation dialogue window! Instead, a new design vari-
ant, SZ20 Base point with projection is available in the Sheet Metal sub-folder of the Civil Engineering functions
docking window.

(1) Element installation without flanges at the base point, (2) Call up the design variant and select the connecting
edge, (3) with Z-profile (4) with Z-fold
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Service Pack 1 2022 (V 2701)

ALUCOBOND® suspended Polygon (5-8)
From HiCAD 2022 SP1 onwards, suspended ALUCOBOND® panels can now also be installed on 5- to 8-cornered
polygons. The new variant ALUCOBOND® suspended Polygon (5-8) is available for this purpose.
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ALUCOBOND® SZ 20 Polygon (3-8)
For installing ALUCOBOND® SZ 20 tray panels on 3- to 8-cornered polygons, the new ALUCOBOND® SZ 20 Poly-
gon (3-8) variant is available as of SP1. This means that it is now also possible to install SZ20 tray panels on equi-
lateral triangles and on 5- to 8-cornered polygons. It is possible to configure individually how the individual edges of
the installation surface are to be processed. In this way, it can be determined at which point the S and Z profiles are
to be created during installing.
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Example:

The installation surface consists of two hexagons. The installing is done without configuring the edges here.

In the image below, installing is done with configuring the edges:

44024 = S-profiles -44025 = Z-profiles
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Extended selection options for ALUCOBOND® suspended
As of HiCAD 2022 SP1, the connection for the Base point is extended by the Window connection, Lintel option.
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Number of stiffeners for ALUCOBOND® SZ 20 tray panel and ALUCOBOND® suspended
For the variants ALUCOBOND® SZ 20 tray panel (with accessories) and ALUCOBOND® suspended, the number
of stiffeners can now be defined on the Extended settings tab.
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Major Release 2022 (V 2700)

Licensing
From HiCAD 2022 onwards the Plot Manager is part of the HiCAD ALUCOBOND® suite premium.

Corner types for triangular SZ20 tray panels
For triangular ALUCOBOND® SZ20 tray panels you can now configure which variant of the acute corner is created.
For this purpose, the new Triangular flange area is available on the Extensions for SZ-20-Standard tab
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As Corner type, you have the choice between Open and Triangular flange. Open corresponds to the previous
HiCAD behaviour, where the corner did not receive any further processing and remained open. Alternatively, you
can select the type Triangular flange, which creates a triangular flange including rivets for fastening.

Left: Corner version "Open"; Right: Corner version "Triangular flange"

If Triangular flange was selected as the corner version, you can also define a Lengthening of triangular flange. In
this case the flange will be lengthened by the value entered here.

The triangular flange from the example above, extended by 50mm
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Fasteners and fixing consoles by EJOT
Fasteners and brackets from EJOT have been added to the HiCAD catalogue. The following catalogues have been
added or supplemented with new parts:

n Factory standards > User-defined processings > User-defined bores > Ejot:

n EJOT bores

n Centring sleeves EJOT

n Factory standards >User-defined processings > User-defined countersinks > Templates :

n Conical countersink

n Conical countersink with lowering

n Factory standards > User-defined processings > User-defined dowels > Ejot:

n SDF-KB (expanded)

n SDF-S

n SDP-KB (expanded)

n SDP-S

n Sieve sleeve

n Factory standards > User-defined fasteners > User-defined rivets:

n ECORIV

n Factory standards > User-defined fasteners > User-defined bolts+screws > Ejot:

n JA3-LT

n JF3

n JF3-LT

n JF6

n JT3-2 (expanded)

n JT3-6 (expanded)

n JT3-LT

n JT4-3H (expanded)

n JT4-4

n JT4-6

n JT4-FR (expanded)

n JT4-LT

n JT4-LT-XT

n JT4-S

n JT4-STS

n JT4-XT

n JT6-12

n JT6-2 (expanded)

n JT6-2H-Plus

n JT6-6 (expanded)
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n JT9-2

n JT9-3H (expanded)

n JT9-4

n JT9-6

n JT9-FR (expanded)

n JZ3-ZT (expanded)

n SDF-KB

n SDF-S

n SDP-KB

n SDP-S

n Factory standards > Series > Roof Wall Facade > Special profiles > Ejot:

n Support profiles

n Factory standards > Purchased/Factory standard parts > Insulation holders:

n Insulation holders EJOT

n Factory standards > Purchased/Factory standard parts > Sleeves:

n Centring sleeves EJOT

n Factory standards > Purchased/Factory standard parts > Shear connector cartridge > Ejot:

n Mortar cartridge Multifix USF

n Mortar cartridge Multifix USF Winter

n Factory standards > Purchased/Factory standard parts > Wall consoles > Ejot:

n CF Console K1

n CF Console Mouse

n Powerkey
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ALUCOBOND® easy fiX
The new ALUCOBOND® easy fiX panels are now also available for Element Installation.
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You can choose between the fastening modes 90°, 135°, Bolted to profile or Bolted to sub-structure.
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Plant Engineering

Service Pack 2 2022 (V 2702)

Discontinuation of the Import PartSolutions part function
As of HiCAD 2022 SP2, the function Import PartSolutions part is no longer available.

Delete several parts - Saving of dialogue settings

The dialogue settings of the Delete several parts function were previously always retained only for the current
HiCAD session.

From HiCAD 2022 SP2 onwards, the settings are saved when the dialogue is closed with OK and are preset the next
time the dialogue is opened. This does not only apply to the current HiCAD session. Please note, however, that the
settings under Additional conditions are not taken into account!

Automatic flow assignment during automatic part insertion

When using the AutoPlace parts on guidelines function, a consistent flow at the corners of the guideline is
important, especially when placing knees, because the flow direction affects the insertion direction.

Accordingly, this function checks whether the flow is consistent. If this is not the case, the function was previously
aborted with a corresponding message and the corresponding point was marked with an arrow.

As of HiCAD 2022 SP2, you have the option to have the flow direction corrected automatically in such cases. The fol-
lowing message is displayed for this purpose:

If you select Yes, HiCAD automatically reassigns the flow, i.e. overwrites it. The input dialogue then starts again from
the beginning.

If you select No, the function is terminated and the position where the inconsistency exists is marked with an arrow
as before.
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If necessary, you can then correct the flow yourself using the Edit flow function.

Insert pipe clamp as sub-part

With the new Pipe parts function , it was previously not possible to place a pipe clamp freely in space. In the
event that the pipe clamp is to be inserted as a sub-part of a fixed superordinate part, this restriction has been
removed as of HiCAD 2022 SP2. In this case, the pipe clamp is not part of a pipeline, so free placement does not cre-
ate an invalid pipeline structure.
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Sheet number at transitions of divided isometries
An isometric drawing can be divided into several sheets by assigning division points. For annotating the inter-
sections (i.e. the division points in the isometry) there is a special text object type ISD_ISOCUT.FTD, which can be
configured in the isometry settings like the other text object types. In this way, the annotations are generated auto-
matically when the isometry is created.

Useful as annotations are for example
n the coordinates (attribute %PIPE_X_COOR) or
n the division index (attribute %PIPE_ISOSPLIT_IDX).

The division index can be used to directly read where the isometric drawing is continued. However, the division
index has no direct reference to the sheet number. Especially when there are many subdivisions, finding the next
partial drawing can sometimes be rather difficult.

As of HiCAD 2022 SP2, the output of the Number of follow-on sheet (attribute %ISO_CONTINUED_ON) is useful
here. This attribute refers directly to the sheet on which the isometric drawing is continued.

For annotating the intersections (i.e. the separation points in the isometry) there is a special text object type ISD_
ISOCUT.FTD, which can be configured in the isometry settings like the other text object types. In this way, the
annotations are generated automatically when the isometry is created.
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To make it even easier to follow the sequence of the sheets containing the partial drawings, HiCAD additionally takes
into account the flow at the division points and thus determines the sequence of the sheets.

Example:

In the isometry shown below, three division points are defined and then the isometry is recreated for the three res-
ulting sections.
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The sequence of the sheets is based on the flow between the different sections.

Generally, the longest path between the sections is determined that follows the flow. However, this only works if the
flow through the sections is directed and acyclic, i.e. has no circles. Otherwise, the leaf sequence is determined
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arbitrarily by HiCAD. In the above example, however, the flow meets the requirements and the result then looks as
follows:

The number of the follow-on sheet (attribute%ISO_CONTINUED_ON) is not preset on the ISD side in
the file the ISD_ISOCUT.FTD. If the attribute is to be output in the partial drawings of the isometry, you
must adjust the FTD file manually.

Search and replace in variants
A variant is described by various attributes, some of which are identical or almost identical for all sub- types.
Examples of this are the file name or the order note.

In practice, it can happen that a series of attributes must be changed in several variants. In this case, it would be
very time-consuming to open and adjust each variant individually.

In this case, the Variant Editor offers the possibility of searching several variants for an attribute and replacing the
current value with another one.

The Search & Replace is done via the command line call of the Variant Editor with the call parameter searchAndRe-
place.
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Derive pipe class with content

As of SP2 a new function for pipe classes is available in the HELiOS Desktop: Derive pipe class ... . Use this
function to create a copy of the pipe class including all its sub-types.

Variants can be taken over in their current state or can be derived and assigned to the new pipe class. (see also
HELiOS Desktop - What's new?)
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Service Pack 1 2022 (V 2701)

Dynamic route change - Pipeline transitions
If you move the cursor over a pipeline transition during the dynamic route change, a corresponding note will now be
displayed. This is the case when two pipelines meet.
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The info text is always placed at the outer diameter of the pipes at the pipe transition. This is independent of how the
view is rotated.
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Insert pipe part

The function Pipe parts has been extended.

Active pipeline

The name of the active pipeline is now displayed in the upper area of the tab.

Newly added parts will be subordinated to this pipeline, provided there is nothing to the contrary, e.g. the placing of
a part on a guideline. In such a case, the part must be assigned to the same pipeline as the guideline.

You can change the active pipeline within the dialogue. To do this, click on the symbol and then select a
pipeline in the drawing or in the ICN.

If you click in the name field, the active pipeline is highlighted in the drawing. Clicking again removes the high-
lighting.

Displaying and selecting the active pipeline in the dialogue makes it easier to connect parts to existing pipelines if
the new part to be inserted is to be assigned to another pipeline.

If you want to define the pipeline assignment depending on the connecting point (standard behaviour

before HiCAD 2022 SP1), click on the symbol. The symbol changes to and the active
pipeline is no longer fixed but follows the connecting point.

Also note that the pipe class suggested in the search criteria now follows the active pipeline.
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Select own part type

If you have defined your own part types, e.g. valves, an arrow symbol is displayed next to the part type. Clicking on
the symbol displays a list box with the corresponding part types.

Show flow direction

When inserting parts, the flow direction is now shown on the guidelines. The flow direction arrows are always shown
on the guideline over which the mouse has been moved.

What's new? 243 / 290

News Overview



Automatic loose flange insertion

The settings in the dialogue window have been adjusted. The Divisible pipes tab has been renamed and an option
for loose flange insertion has been added. This setting corresponds to the setting for automatic loose flange insertion
on the Straight pipes tab in the Plant Engineering settings.

Reference part filter

The selection of a reference part in the new part dialogue has been extended by an additional button with
which you can filter the selection by the active part type.

This button is only available if a part type is selected at the top of the dialogue. In contrast to the usual selection of a
reference part, only a part with the selected part type can be selected.
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This selection mode is intended for parts that are difficult to select without narrowing the part type. For example, a
gasket may be completely hidden by a fastener. Through the filtered selection, though, it can still be selected.
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BOM-relevance of manually inserted gaskets
If the Plant Engineering setting Flange gasket: Do not consider was active, then manually inserted gaskets were not
BOM-relevant until now. They were listed as accessories in the flange, but not in the BOMs. As of HICAD 2022 SP1,
these gaskets are always BOM-relevant.

EN 10241 - Additional threaded parts
The range of parts in HICAD has been extended by the following variants:

n Nozzles

l EN10241_WELDED_NIPPLE_R208_1.VAA

n Sadddle connections

l EN10241_WELDED_NIPPLE_R208_2.VAA

n Other pipe parts

l EN10241_NIPPLE_R210.VAA
l EN10241_SOCKET_R201.VAA
l EN10241_WELDED_NIPPLE_R208.VAA
l MUFFE_DIN2986.VAA (previously only available as nozzle)
l NIPPEL_DIN2982.VAA (previously only available as nozzle)

Isometry / Pipe spool drawing -Existing article masters
In the Configuration Editor at Plant Engineering > Isometry and Pipe spool drawing the parameter Show pipeline
article for editing can now be used to determine whether the article mask of the pipelines should be displayed or not
before generating the isometry/pipe spool drawing

Activating the parameter has the following effect when calling the function AutoGenerate drawing / Generate pipe
spool drawing: If the pipelines to be derived are selected in the dialogue and the checkbox Link document is active,
the Edit article master mask is displayed for each selected pipeline so that you can adjust the data if necessary.
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Major Release 2022 (V 2700)

New part insertion function

The Pipe parts function for inserting parts in Plant Engineering has been completely revised.
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In this dialogue window you have full control over which search criteria are used to find a part.

The previous function for the installation of pipe parts is still available.

A separate function is now available for the insertion of P+ID parts:

Insert P+ID part

Please note that not all Plant Engineering settings are relevant for the new part insertion function. This is marked
accordingly on the corresponding help pages.

Activate pipeline via list
Since HiCAD 2020 (V 2500), the active pipeline is determined via the active part. This means: If the active part
belongs to a pipeline, then this pipeline is considered to be an active pipeline. Otherwise, no pipeline is active.
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Up to HiCAD 2019, the pipeline could also be selected via the list of all pipelines using the Activate pipeline via list

function. This function was "reactivated" again with HiCAD 2022. In contrast to the previous function, how-
ever, the selected pipeline now becomes the active part. You can find the function at Plant Engineering > Settings >
PreSel.

A pipeline that is already active before the start of the function is initially highlighted in grey.
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Parts with unchangeable colour
The colour of parts added to a pipeline depends on the Plant Engineering Settings for Part insertion. If the check-
box Take over pipeline colour is active there, the part receives the current colour of the pipeline, to be more precise,
of the part ~parts of the pipeline. If the checkbox is inactive, the part receives the current surface colour set in
HiCAD.

Sometimes, however, it is desirable - especially with elaborate parts - if they retained their original colours during
insertion. For example, the different areas of complex valve parts may have been coloured according to their func-
tion.

In order to mark such parts accordingly, an additional part attribute is available that specifies whether the colour of a
part may be changed during insertion:

Attribute designation Attribute name HiCAD Attribute name HELiOS

Part colour must not be changed FIXCOL FIXED_COLOR

In order for this attribute to be available for the different part types, the file nnnnnnn.CatSearchAtt.txt belonging to a
part type in the HiCAD subdirectory PlantParts\CatSearch must be extended by the line

S:FIXED_COLOR,

with nnnnnnn is the part type identifier.

This has already been preset for the following part types:

Part type

3-way valve 4300010.CatSearchAtt.txt

Corner valve 4200010.CatSearchAtt.txt

4-way valve 4400010.CatSearchAtt.txt

Valve 4100010.CatSearchAtt.txt

Pipe clamp 5810010.CatSearchAtt.txt

Other pipe part 5900010.CatSearchAtt.txt

Gauge part 5920010.CatSearchAtt.txt

If, for example, you also want to use this attribute for Saddle connector, you must adapt the file
6110010.CatSearchAtt.txt accordingly.
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The attribute can be assigned to parts in the variant editor and in the PAA Editor.

To make this attribute available in your HELiOS database, you must first update HELiOS for Plant Engineering.

Please note:

The attribute only applies to the insertion of parts. If the pipe colour is subsequently changed, the colour
of the parts added to the pipe is also changed.
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Pipeline planning - Article attribute for length allowance
The Pipeline planning functionality supports the Length allowance attribute for pipe parts. This allows you to specify
that a part is actually longer than the insertion length. An application case is pipes that are provided with a loose
flange before insertion and then flanged. The flanging of the pipe reduces the insertion length, but the pipe must be
ordered in the original length.

Attribute designation Attribute name HiCAD Attribute name HELiOS

Length allowance ADDLENFIXCOL PIPE_ADDED_LENGTHFIXED_COLOR

To use the length allowance, you must adapt your variant file or the parts archive accordingly. You thus determine
which values are transferred to the length allowance during part data synchronisation. In the example of a variant
shown, this is part variable E1:
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After inserting a part, you will find the entry Length allowance in the drawing in the part information, if such an entry
is available on the part:
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This pipe has an insertion length of 650 and a length allowance of 50. It was inserted with the following settings for
straight pipes:

The maximum pipe length as of HiCAD 2022 is equal to the insertion length plus the length allowance. If you use
pipes with and without length allowance in your drawings, you do not have to worry if the maximum length that can
be installed does not match the maximum length that can be ordered.

Similarly, the HELiOS attribute Supplied length also affects the installable maximum length by deducting the length
allowance.

The length allowance is taken into account in the Total length column of the layout plan BOMs.
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New variants for flared pipes
The following four variants have been added to the pipe part inventory:

n EN10357_PIPE_BEADED_BOTH_PN10_FME4.VAA

n EN10357_PIPE_BEADED_BOTH_PN10_FME8.VAA

n EN10357_PIPE_BEADED_SINGLE_PN10_FME4.VAA

n EN10357_PIPE_BEADED_SINGLE_PN10_FME8.VAA

These are flared pipes, whereby the SINGLE variants are only flared at connection point 1 and the BOTH variants
are flared at both connecting points.

All variants use the new Length allowance attribute.

Isometric drawings and pipe spool drawings - - Article attribute for length allowance
In the BOMs of isometric drawings and pipe spool drawings, too, the length allowance is taken into account.

The columns in these BOMs are filled via configurable text keys, of which the following evaluate the length allowance
from HiCAD 2022 onwards:

%PART_QUANT Returns the insertion length plus the length allowance for straight pipes

%PIPE_LENGTH Returns the insertion length plus the length allowance

%LENGTH_
COUNT

Counts pipes of the same length, where insertion length plus length allowance must be
equal.
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In the list settings, these text keys are normally used as shown below:
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Isometric drawings and Pipe spool drawings - Presetting editable columns
In the Settings dialogue for Isometric drawings and Pipe spool drawings, the BOMs that are to be automatically inser-
ted into an Isometry or Pipe spool drawing can be configured on the Lists tab. In particular, individual columns of
the BOM tables can be provided with the special text key %USR, which makes the column editable. This is done via
the Editable column button.

Clicking on this button inserts a text key of the form %USR(XXXXXX), where XXXXXX is a randomly generated char-
acter string under which the entries are stored in the pipeline, so that they can be restored when the BOMs are gen-
erated again.

When initially creating an isometry, the editable columns were previously empty. From HiCAD 2022 you can now
store a default value in the %USR text key by separating it from the random string with a colon.

Example:

The 5th column with the title Comment is editable and as text key %USR(PTL8NR:Important!) has been entered.
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The result looks as follows:
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Isometric drawings and Pipe spool drawings - Editing Bills of Materials (BOMs)
As of HiCAD 2022, editing bills of materials in Isometric drawings and Pipe spool drawings and Pipe plan no longer
requires a Plant Engineering licence. To edit a bills of materials table, right-click on the table and select Edit.

The ISD has made this licence change to make it more flexible for customers to fill in BOMs at a later date. For
example, additional information that the actual designer does not have can be added subsequently.

The following should be noted:

The appropriate settings files must be available on the computer used to process the BOMs. The relevant settings
can be found in the HiCAD sys directory in the files

n Anl3DIso.xml and

n Anl3DSpool.xml

as well as in the list configuration files. If you have not created your own configuration files, these would be the files
ListDef.ild.xml and Listdef.sld.xml.

If these files do not exist, a corresponding message appears.
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HELiOS database - New attributes
As described above, new part/article attributes are available as of HiCAD 2022:

Attribute designation Attribute name HELiOS

Part colour must not be changed FIXED_COLOR

Length allowance PIPE_ADDED_LENGTH

To ensure that these attributes are also available in your HELiOS database, you must first update HELiOS for Plant
Engineering. To do this, use the tool DbPlantDataImport.exe.
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Revised variants JISB2301
The variants of the standard JISB2301 have been revised. The previous variants of this standard will no longer be
supplied.

The following variants are no longer available:

JISB2301-99_CLASS1_45_ELBOWS.vaa

JISB2301-99_CLASS1_45_LATERALS.vaa

JISB2301-99_CLASS1_ELBOWS.vaa

JISB2301-99_CLASS1_MF_SHORT_BENDS.vaa

JISB2301-99_CLASS1_RED_MF_SOCKETS.vaa

JISB2301-99_CLASS1_REDUCING_NIPPLES.vaa

JISB2301-99_CLASS1_REDUCING_SOCKETS.vaa

JISB2301-99_CLASS1_RETURN_BENDS.vaa

JISB2301-99_CLASS1_SHORT_BENDS.vaa

JISB2301-99_CLASS1_SOCKETS.vaa

JISB2301-99_CLASS1_TEES.vaa

JISB2301-99_CLASS1_TEES_INC_BRANCH.vaa

JISB2301-99_CLASS1_TEES_RED_BRANCH.vaa

JISB2301-99_CLASS1_TEES_RED_RUN_BRANCH.vaa

JISB2301-99_CLASS1_TEES_RED_RUN_BRANCH_EQ.vaa

JISB2301-99_CLASS2_45_ELBOWS.vaa

JISB2301-99_CLASS2_45_LONG_SWEEP_BENDS.vaa

JISB2301-99_CLASS2_45_MF_ELLBOWS.vaa

JISB2301-99_CLASS2_ELBOWS.vaa

JISB2301-99_CLASS2_LONG_SWEEP_BENDS.vaa

JISB2301-99_CLASS2_M_LONG_SWEEP_BENDS.vaa

JISB2301-99_CLASS2_MF_45_LONG_SWEEP_BENDS.vaa

JISB2301-99_CLASS2_MF_ELLBOWS.vaa

JISB2301-99_CLASS2_MF_LONG_SWEEP_BENDS.vaa

JISB2301-99_CLASS2_MF_SHORT_BENDS.vaa

JISB2301-99_CLASS2_MF_SOCKETS.vaa

JISB2301-99_CLASS2_PITCHER_TEES.vaa

JISB2301-99_CLASS2_PITCHER_TEES_RED_BRANCH.vaa

JISB2301-99_CLASS2_PITCHER_TEES_RED_RUN.vaa

JISB2301-99_CLASS2_PITCHER_TEES_RED_RUN_BRANCH.vaa

JISB2301-99_CLASS2_REDUCING_MF_ELLBOWS.vaa

JISB2301-99_CLASS2_SHORT_BENDS.vaa

JISB2301-99_CLASS2_SOCKETS.vaa

JISB2301-99_CLASS2_TEES.vaa
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JISB2301-99_CLASS2_TEES_INC_BRANCH.vaa

JISB2301-99_CLASS2_TEES_RED_BRANCH.vaa

JISB2301-99_CLASS2_TEES_RED_RUN_BRANCH.vaa

JISB2301-99_CLASS2_TEES_RED_RUN_BRANCH_EQ.vaa

The following variants are new:

JISB2301-99_CLASS1_45_ELBOW.vaa

JISB2301-99_CLASS1_45_LATERAL.vaa

JISB2301-99_CLASS1_45_LATERAL_.vaa

JISB2301-99_CLASS1_ELBOW.vaa

JISB2301-99_CLASS1_MF_SHORT_BEND.vaa

JISB2301-99_CLASS1_REDUCING_NIPPLE.vaa

JISB2301-99_CLASS1_REDUCING_SOCKET.vaa

JISB2301-99_CLASS1_RED_MF_SOCKET.vaa

JISB2301-99_CLASS1_RETURN_BEND.vaa

JISB2301-99_CLASS1_SHORT_BEND.vaa

JISB2301-99_CLASS1_SOCKET.vaa

JISB2301-99_CLASS1_TEE.vaa

JISB2301-99_CLASS1_TEE_INC_BRANCH.vaa

JISB2301-99_CLASS1_TEE_RED_BRANCH.vaa

JISB2301-99_CLASS1_TEE_RED_RUN_BRANCH.vaa

JISB2301-99_CLASS1_TEE_RED_RUN_BRANCH_EQ.vaa

JISB2301-99_CLASS2_45_ELBOW.vaa

JISB2301-99_CLASS2_45_LONG_SWEEP_BEND.vaa

JISB2301-99_CLASS2_ELBOW.vaa

JISB2301-99_CLASS2_LONG_SWEEP_BEND.vaa

JISB2301-99_CLASS2_MF_45_ELBOW.vaa

JISB2301-99_CLASS2_MF_45_LONG_SWEEP_BEND.vaa

JISB2301-99_CLASS2_MF_ELBOW.vaa

JISB2301-99_CLASS2_MF_LONG_SWEEP_BEND.vaa

JISB2301-99_CLASS2_MF_SHORT_BEND.vaa

JISB2301-99_CLASS2_MF_SOCKET.vaa

JISB2301-99_CLASS2_M_LONG_SWEEP_BEND.vaa

JISB2301-99_CLASS2_PITCHER_TEE.vaa

JISB2301-99_CLASS2_PITCHER_TEE_RED_BRANCH.vaa

JISB2301-99_CLASS2_PITCHER_TEE_RED_RUN.vaa

JISB2301-99_CLASS2_PITCHER_TEE_RED_RUN_BRANCH.vaa

JISB2301-99_CLASS2_REDUCING_MF_ELBOW.vaa
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JISB2301-99_CLASS2_SHORT_BEND.vaa

JISB2301-99_CLASS2_SOCKET.vaa

JISB2301-99_CLASS2_TEE.vaa

JISB2301-99_CLASS2_TEE_INC_BRANCH.vaa

JISB2301-99_CLASS2_TEE_RED_BRANCH.vaa

JISB2301-99_CLASS2_TEE_RED_RUN_BRANCH.vaa

JISB2301-99_CLASS2_TEE_RED_RUN_BRANCH_EQ.vaa

JISB2301_Pipe.vaa

For easy transfer to your database the parts are listed in the JISB2301.lst list in the PlantParts directory. Use the Part
Data Synchronisation function for transfer.
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Notes on HELiOS Updates
For an update to HELiOS 2021 (Version 2600) from a version older than 2500 a central update of the supplied
HELiOS database is required.

Since conflict may occur during the update process in case of inconsistent data stocks, you should do the following:

n Data backup before updating

Make sure that a data backup was made before carrying out the update of your HELiOS database.
For the backup, either use the HELiOS Database Creator (further information can be found in the Installation
Notes) or your SQL Server Application.
In case of any questions, or if you need any help with regard to your customized system architecture , contact
the ISD Hotline.

n Log file for update

If any conflicts occur during the update, these will be recorded in the log file HeliosDbUpdate.txt (in the system
path %appdata%\ISD Software und Systeme\HeliosDbUpdate\).
Have this file ready when contacting the ISD Hotline in case of an unsuccessful update, so that they can help
you solve the problem and make a successful update.

n New mask format

Please read all notes on the new mask format introduced with HELiOS 2020 !

n MultiCAD interfaces

If you are working with an Inventor or SOLIDWORKS interface and HELiOS, please note that before installing an
update of an older version to HELiOS 2020 (Version 2500) or higher, some adjustments may have to be made
before the update.
In this case, please contact the Consulting department of the ISD Group.
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HELiOS Desktop

Service Pack 2 2022 (V 2702)

Derive projects and folders without content
The functionality for deriving projects or folders "without content" has been revised.

If you want to create a copy of a project or a folder via a derivation without copying the content of the object (doc-
uments, articles, other objects), then you have the option of selecting individual sub-projects or sub-folders of the

respective structure via an extended dialogue after calling Derive project, without content... or Derive
folder, without content....

You can make changes to master data (designations, responsible agents, etc.) in the dialogue in the input mask of
each individual project or folder.

You can also adapt the Workflow of the underlying object at this point or assign a different one to the derivation.
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Derive pipe class with content

With the help of the new Derive pipe class with content… function you can derive a pipe class including all its
variants. Variants can be taken over in their current state or can be derived and assigned to the new pipe class.
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Output settings for inches and feet
If you work with inches and feet as length units in HELiOS, you have extended setting options to influence the dis-
play of the output in detail via a configuration dialogue for result list columns.

Combined decimal and fractional formats are also possible and you can manually set the accuracy of decimal
places as well as the denominator of the fraction calculation.

On the General tab of the HELiOS Options dialogue window, you can also determine whether the Length display for
feet and inches is output according to the American (in, ft) or British standard (",').
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Copy & Paste attribute values with unit category
When copying & pasting attribute values via the Clipboard, even from one application to another, e.g. from HELiOS
to an ERP system or Word, unit categories of FLOAT attributes will be considered as follows:

The Copy attribute value function copies a value to the clipboard as it is displayed for you in the result list.
I.e.: If the unit (e.g. cm or inches) is also displayed in the corresponding result list column, it will also be copied.

When pasting into a target attribute with a different base unit, the value will then be converted accordingly.

If no unit was copied to the clipboard, the corresponding number is also interpreted in the standard display unit of
the target attribute when it is pasted.

Open, with options: Open drawings in reduced mode
The options dialogue for reduced loading of HiCAD documents (.sza files) has been revised to match the standard
you are used to from HiCAD.
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Service Pack 1 2022 (V 2701)

Windows 11 and Windows Server 2022
With the update to Service Pack 1, HELiOS 2022 supports the operating systems Windows 11 and Windows Server
2022.

Locking Manager (formerly ReleaseNext)
Please note that the tool for unlocking HELiOS objects, which was called "ReleaseNext" in earlier versions, has been
renamed to Locking Manager (Lockingmanager.exe) as of Service Pack 1.

Also, the user interface and functionality have been revised.

Mask Editor: Improved element alignment functions
The range of functions of the Mask Editor has been improved to the extent that the alignment of elements also works
across group boxes.

This means, for example, that data fields from different group boxes can be aligned together.

The group box elements are then moved automatically, provided there is sufficient space. If group boxes have to be
extended (to the right or downwards), this also happens automatically, but the size is retained.
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Workflow selection for object data input
If there are different Workflows that can be assigned to a HELiOS object type (e.g. a document) when the cor-
responding document input type is executed, you can make the selection via a pull-down menu at the bottom of the
window. The selection via a separate dialogue window is no longer necessary.

Units contained in delivered database
The delivered databases of HELiOS 2022 Service Pack 1 contain newly assigned unit categories and cor-
respondingly adapted masks for many (FLOAT) attributes. The default display of units is in the metric system.

The default configuration for result lists is set so that unit symbols are displayed in column headings.

The changes primarily affect new installations of HELiOS; existing data and masks are not replaced by update install-
ations.

Note on decimal separators
Decimal separators may differ from country to country: In some countries the comma (,) is used, in others the dot
(.).

In order to meet the requirements of international work, HELiOS always allows both for entries of the data type
FLOAT!

PDF preview in the HELiOS Desktop
Please note that the PDF preview in the HELiOS Desktop no longer works with Acrobat Reader DC from Version
2021.011.20039.

As an alternative, we recommend using Foxit Reader. Before installing it, you must uninstall Acrobat Reader DC.
You may also have to adjust the configuration file hel_preview.ini if Acrobat Reader was explicitly defined for PDF
preview there. The corresponding entry needs to be removed.
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Major Release 2022 (V 2700)

Discontinuation of the ISD.PDM.API

Before carrying out a HELiOS update for an older HiCAD version, please note that from HELiOS 2022 omwards, the
previous ISD.PDM.API will be discontinued and replaced by the new API from Helios.Interface. If you use cus-
tomisations that use functionalities from the previous ISD.PDM.API, you must update the customisations to the new
API before carrying out the HELiOS update. If you use customisations that use functionalities from the HiCAD API,
you should ensure that the HiCAD version used is at least version 2502.5 or 2601.1 or newer. If you are unsure
whether you are using corresponding adaptations, please talk to your administrator or contact the ISD in case of
doubt.

HELiOS.Interface-API
The HELiOS.Interface API is an API independent of HiCAD with which you can conveniently create, search for or
change objects such as Projects, Documents and Articles. Workflow editing can also be facilitated with the API.

Working with the API does not require an additional module, but it does require participation in a training
course and programming knowledge.

Enhancements in handling units
In order to further meet requirements for international work, HELiOS 2700 has extended the range of functions for
the display of units (e.g. units of measurement, time) accordingly.

With the help of HELiOS's attribute management, you can work at database attribute level with unit categories that
also distinguish between EU and US units.

When installing a new HELiOS standard database from Version 2700 onwards, the corresponding unit categories
including the standard unit are already defined for many FLOAT attributes. Legacy data are not initially converted by
update installations, but you can do so by manually changing the unit category once.

The Standard unit for display stored in the HELiOS Attribute Editor is then used accordingly for display in result
lists.

Via the context menu (right-click) of result lists columns, which are corresponding attributes with unit category, you
then also have two new display options with unit and unit symbol, which can deviate from the defined standard dis-
play for individual attributes.

The unit is also displayed in masks, provided it has been defined accordingly in the Attribute Editor. This also
applies to input masks, where you will see the defined unit for display even when making entries or changes.
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You will also see corresponding information on the unit in the Properties window of HELiOS:

Due to the change of units, there has also been a change in the interpretation of the decimal separator for FLOAT
attributes: A German HELiOS version uses the comma, an English version the point as decimal point. For the user,
this also has the advantage that the numeric keypad can be used sensibly in this respect.

If you work with unit categories, the standard display units of relevant attributes are also output when transferring
product structures to the Report Manager. The standard display unit is also used when displaying the attributes in
the product structure tree.

Important note for HiCAD users

If you work with the HiCAD-HELiOS interface and want to use units for attributes that are relevant for coupling,
you must work with a HiCAD version >= 2022 (V. 2700.0).

MultiCAD interfaces

Since attribute values stored in the database may change when changing the units (or unit categories), you
should configure the attribute mapping when working with MultiCAD-interfaces so that the imported values are
in the correct base unit.

ERP interfaces and KSTs (customer interfaces)

For interfaces to ERP systems or similar., it should be taken into account that conversions may be necessary.
As of HELiOS Version 2022 (v. 2700.0), the PDM API always returns values in the base unit for attributes with
units. If you use your own adaptations, you may have to adapt them.

KSTs (customer interfaces) of the ISD are also affected.
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Open, with options from result lists

As with the functions Open + Edit or Open, read-only, you can also execute the function Open,
with options of HELiOS documents directly from result lists via a button.

To do this, you only need to add the attribute UI_OpenWithOptionsItem to the corresponding result lists via the
attribute configuration.

The dialogue has been extended by further selection options, which mainly concern the MultiCAD interfaces:

Via the menu items Updating of attributes and Updating of components to newer indices you can control the load-
ing behaviour of documents in such a way that the updating of database attributes or the document revision is
restricted or prevented altogether.
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This makes sense, for example, if you only want to load documents of large assemblies in read-only mode for view-
ing instead of editing and want to save performance time.
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Show Classification tab in Find document/article dialogue
You now have the option of setting whether or not the Classification tab should be displayed in the respective search
window for documents or articles (or in the combined search window):

In the HELiOS Options dialogue window, open the General tab and, under Find, activate the Show Classification tab
in Find document/article dialogue checkbox.

The checkbox is deactivated by default.

Edit attribute values
In the HELiOS UI there are various ways to change the values of certain attributes: For example, you can call the
function Edit attribute values in detail masks of objects, whereupon all attributes of the corresponding HELiOS
object (Article, Document, Project, ...) are listed in the dialogue window. At this point you have the possibility to
change the attributes that may be changed.

Alternatively, you can also right-click on a specific attribute field in result lists and then call up the Edit attribute val-
ues function from the context menu to change this specific value (if it is permitted).

The range of functions and editing options at these points has been extended.

For example, you can edit the current revision index of a HELiOS object in this way even without administration
rights.
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Basically, all possible attributes of a corresponding object type are available for editing in the editing dialogue.
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Copy & Paste attribute values
In addition to the extensions of the range of functions for editing attribute values, the possibility of copying and past-
ing attribute values via the clipboard has been created.

Right-clicking on the field of a result list and selecting Copy attribute value copies the corresponding attribute

value to the clipboard, right-clicking in another field of a result list and executing Paste attribute value writes
the copied value into the corresponding attribute field.

Multiple selection of target objects to transfer the copied value to several fields simultaneously is also possible.

Of course, you can also transfer the copied attribute value in this way to other applications such as Office or to an
ERP system.

The former "Copy number" function is therefore no longer available.
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Create follow-on sheet with link

The behaviour of the document input function Create follow-on sheet, with link has been modified to con-
sider only links whose automation behaviour has been defined with Apply when creating new follow-on sheets.

This behaviour is analogous to the taking over of links in connection with the creation of revision indices and ensures
that only reasonable links to the follow-on sheet are created.
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Optimised performance for Combined search
When working with the Combined search, it could happen in the past that executing the search without specifying
further search conditions resulted in longer loading times, as in this case all entries of the database are listed for the
selected links.

For HELiOS 2022 (v. 2700) a significant performance improvement could be achieved at this point.

With 160,000 search results, it takes only about 5 seconds to build up the list of results (with only very low latency to
the database).
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Workspace Manager
The Workspace Manager is a cross-application tool for session management of HELiOS documents.

Since its use, which used to be required mainly for the multi-CAD interfaces, can now also be relevant when working
with the HELiOS Desktop or the HELiOS Office interface, you will find the call in the HELiOS Options at Database >
General > Local session.

Uploading files from HELiOS into the ISD File Centre
In the Help menu of the HELiOS Desktop and the mask editor you will find the new menu item

Upload file into the ISD File Centre... .

With the help of this function you can upload files directly from HELiOS into the ISD File Centre, e.g. in connection
with the ISD Support for an already existing support ticket.
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List attributes: Support only for VARCHAR attributes
When working with the Attribute Editor, please note the correction that with the update to HELiOS 2022 list attributes
can no longer be used for data types other than VARCHAR.

If list attributes of data types other than VARCHAR are found during a database subversion update, you will receive a
corresponding error message. In this case, please contact the ISD in order to migrate with the help of the Consulting
the corresponding attributes to data types that will be supported in the future.

Customization: Withdrawal of the old system files kstext_StdKop.dll and teilhost_next.exe
Please note the following, if you work with customer specific projects or with an ERP interface:

Starting with HELiOS 2022 (V 2700) some old system files like the DLL kstext_StdKop.dll and the executable file teil-
host_next.exe will be dropped.

Any customizations in your system that used these files in the past must therefore be modified again.

In this case, please contact the Sales or Consulting department of the ISD Group directly.
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HELiOS in HiCAD

Service Pack 1 2022 (V 2701)

Performance
With the update to Service Pack 1, significant performance improvements could be achieved in the context of the
HELiOS/HiCAD interface.

For example, the transfer of the HiCAD product structure to the HELiOS database could be accelerated by a factor of
5..

International (non-metric) units
To further meet requirements for international work, the range of functions for displaying units (e.g. units of length or
volume or time) was expanded accordingly with HELiOS 2022: With the help of HELiOS's attribute management,
you can work at database attribute level with unit categories that also distinguish between EU and US units.

The HELiOS/HiCAD interface also implements this accordingly.
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Major Release 2022 (V 2700)

Output of units via the Report Manager
If you work with the unit categories introduced in HELiOS 2022, you have the possibility to output the standard dis-
play units of relevant attributes also when transferring HiCAD product structures to the Report Manager.

The standard display unit is also used when displaying the attributes in the product structure tree.

Please note that Version 2022 (V 2700.0) of both HELiOS and HiCAD must be installed on the system.
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HELiOS Vault Server

Major Release 2022 (V 2700)

Improved replication behaviour
Some optimisations in the behaviour of the Vault Server guarantee a stability gain in replication management
between different locations with the current HELiOS version. This improvement also affects cloud environments in
particular.

In addition, cross-site replication has been improved to work stably in the case of "overlaps" that can occur with very
short update intervals (i.e.: a current replication is still running while the next one is already initiated).
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Legal notes
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